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Adressaten dieses Papiers

¢ Anwender von Software, die zur Bereitstellung eines Datentragers/Datenpakets nach
GDPdU/GoBD aufgefordert werden.

o Entwickler von Software, die steuerrelevante Daten fur die Datentrageriiberlassung nach
GDPdU/GoBD bereitstellen.

Zusammenfassung/Ziel

Nach § 147 Abs. 6 AO ist es der Finanzverwaltung méglich, die Daten von elektronischen
Buchfuhrungssystemen ,digital“ zu prifen, entweder durch Datentragertiberlassung und/oder
durch mittelbaren bzw. unmittelbaren Zugriff.

Fur die Datentragertberlassung ist es notwendig, dass die Daten von dem steuerpflichtigen
Unternehmen (oder dem beauftragten Steuerberater, buchfihrenden [Sub-]Unternehmen
etc.) in ,maschinell auswertbarer Form* auf geeigneten Datentragern bereitgestellt werden.

Unter dem Begriff der ,maschinellen Auswertbarkeit* versteht die Finanzverwaltung den
wahlfreien Zugriff auf alle gespeicherten Daten einschliel3lich der Stammdaten und
Verknipfungen mit Sortier- und Filterfunktionen.

Um eine solche Auswertbarkeit oder Verwertbarkeit zu erreichen, ist es notwendig, dass die
Dateiformate fir die Datentragertiberlassung definiert und standardisiert werden.

In diesem Dokument wird ein Verfahren vorgestellt, das die definierte und standardisierte
Datentrageruberlassung ermgglicht und einen Standard fiir die Software-Industrie
beschreibt.

Bei Ruckfragen wenden Sie sich bitte per E-Mail an GDPdU@audicon.net oder informieren
Sie sich unter https://www.audicon.net.

Beschreibungsstandard GDPdU/GoBD 5
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Text von § 147 Abs. 6 AO

In der Fassung des Gesetzes zur Senkung der Steuersatze und zur Reform der
Unternehmensbesteuerung (Steuersenkungsgesetz — StSenkG) vom 23.10.2000 BGBI. |
2000 S. 1433:

(6) Sind die Unterlagen nach Absatz 1 mit Hilfe eines Datenverarbeitungssystems erstellt
worden, hat die Finanzbehdrde im Rahmen einer Auf3enprufung das Recht, Einsicht in
die gespeicherten Daten zu nehmen und das Datenverarbeitungssystem zur Prifung
dieser Unterlagen zu nutzen. Sie kann im Rahmen einer Aul3enprufung auch verlangen,
dass die Daten nach ihren Vorgaben maschinell ausgewertet oder ihr die gespeicherten
Unterlagen und Aufzeichnungen auf einem maschinell verwertbaren Datentrager zur
Verfligung gestellt werden. Die Kosten tragt der Steuerpflichtige.

Datentrageruberlassung
Ein mogliches Szenario fir eine Steuerprifung mit Datentréageriberlassung:

Ein Steuerprifer bekommt den Auftrag, ein Unternehmen zu prifen. Fur bestimmte
Prufungsfelder und Prifungszeitrdume beschliel3t der Steuerprufer, die Daten unter
Zuhilfenahme von Prifungssoftware zu analysieren. Entsprechend werden dem
Unternehmen die Prifung angekiindigt und die Prifungsschwerpunkte bekanntgegeben. Der
Steuerprifer bittet das Unternehmen, die steuerlich relevanten Daten auf einem maschinell
auswertbaren Datentrager nach den Vorgaben der ,Grundsatze zum Datenzugriff und zur
Prifbarkeit digitaler Unterlagen” (GDPdU) gemafll BMF-Schreiben vom 16.07.2001 bzw. der
,Grundsatze zur ordnungsmafigen Fuhrung und Aufbewahrung von Blichern,
Aufzeichnungen und Unterlagen in elektronischer Form sowie zum Datenzugriff‘ (GoBD)
gemal BMF-Schreiben vom 28.11.2019 bereitzustellen.

Bei Prufungsbeginn erhalt der Steuerprifer einen Datentrager oder ein Datenpaket.

Gemalf seinem Priifungsschwerpunkt sucht der Priifer die entsprechenden Tabellen heraus
und liest diese ein. Auf dem Datentrager/in dem Datenpaket sind steuerrelevante Daten und
beschreibende Daten enthalten, um die Daten ohne weitere Erklarungen einlesen zu
kénnen. Sobald die Daten in die Analysesoftware importiert sind, fuhrt der Steuerprufer eine
oder mehrere Analysen (teilweise durch Makros automatisiert) aus.

1. Fordert Datentrager/Datenpaket an
2. Liest Datentrager/Datenpaket ein
3. Fuhrt Analyse aus bzw. lasst Analyse-Makros ablaufen

Abbildung 1: Steuerprifer
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Aus Sicht des Unternehmens fallen bei dem oben beschriebenen Szenario folgende
Arbeitsschritte an:

o Ein Mitarbeiter initiiert die Datenextraktion bzw. den Export aus der
Produktionsdatenbank, wobei die Daten ggf. (automatisch) transformiert werden in dem
Sinne, dass die Datenorganisation, die Struktur der Tabellen oder Objekte gedandert wird.

o Ebenso muss bei komprimierten oder verschliisselten Daten die Komprimierung bzw. die
Verschliisselung aufgehoben werden. Zu den steuerrelevanten Daten muss nun noch
eine Beschreibung in Form einer maschinenauswertbaren Datei erzeugt oder
hinzukopiert werden. Eine solche Datei muss in dem Fall bei der Bereitstellung erzeugt
werden, falls der Softwarehersteller nicht vorhersehen kann, welche Daten bei der
Prifung bereitgestellt werden sollen. Es kann eine statische Datei bereitgestellt werden,
falls im Voraus der Umfang und die Struktur der Daten feststehen.

Die Daten werden anschliel3end automatisch oder manuell auf einem beweglichen
Datentrager/in einem Datenpaket gespeichert.

o Exirakton * Organisation
| l I * Transformation :3::5:5(; T:;Zn

* Komprimierung

Produktivsystem

* Bereitstellung

e SAP

* Datev

e |nfor

* Navision

* Oracle Financials
* Varial

* eigene Software
* andere

Priifer/in

Abbildung 2: Datentrageriberlassung
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Die Datenorganisation bei der Datentragertberlassung

Das BMF-Schreiben vom 16.07.2001 gibt den gepriften Unternehmen bei der technischen
Organisation des zu Uberlassenden Datentragers/Datenpakets grundsatzlich einen breiten
Spielraum.

Nachdem die Finanzverwaltung des Bundes und der L&nder die in der Wirtschaftsprifung
verbreitete Analysesoftware IDEA beschafft hat, sind die Steuerprufer in der Lage, Daten
maschinell zu lesen und (automatisiert oder manuell gesteuert) zu verarbeiten. Die
Finanzverwaltung definiert nicht die Datenfelder und Inhalte, die bei der
Datentrageriiberlassung auf den Datentrager/in das Datenpaket gebracht werden.
Entsprechend ist es notwendig, dass Steuerpflichtige und/oder Hersteller von Software, die
steuerlich relevante Daten verarbeiten, selbst entscheiden, welche Daten bei der
Datentrageriberlassung bereitgestellt werden. Dabei kbnnen je nach EDV-System,
Software-Strukturen, Unternehmensstruktur und -gréRe unterschiedliche Dateninhalte
sinnvoll und notwendig sein.

Um Rickfragen durch den Steuerprifer zu den Dateninhalten und Formaten zu minimieren
oder unndtig zu machen, wird hier ein Verfahren beschrieben, das die Daten,
Datenstrukturen und Verknupfungen beschreibt und kommentiert.

Um die unterschiedlichen Datenstrukturen verarbeiten zu kénnen, stellt der Steuerpflichtige
bzw. sein Berater die steuerrelevanten Daten weitgehend denormalisiert zur Verfiigung.
Zusatzlich liefert er eine maschinenauswertbare Beschreibung der Daten, Datenformate und
Verknipfungen. Das Dateiformat fur die steuerlich relevanten Daten wurde auf gangige
Standardformate festgelegt. Beides — steuerrelevante Daten und Beschreibungsdaten — wird
auf einem gemeinsamen Datentrager/in einem gemeinsamen Datenpaket bereitgestellit.

Steuerrelevante Daten

Datenpaket

1

Beschreibungsdatei:
Datenbeschreibung und- verknipfung

Abbildung 3: Datenorganisation
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Die unterstiitzten Dateiformate fur die steuerlich relevanten Daten sind:

e VariableLength
e FixedLength

Damit ist es den Softwaresystemen madglich, bereits bestehende Exportfilter oder
Speicherungsmechanismen zu nutzen.

Die Finanzverwaltung erlaubt keine Installation von Spezialsoftware zur Entschliisselung
oder zum Dekomprimieren von Daten auf ihren Systemen. Insbesondere beim Postversand
von Datentragern ist jedoch zumindest das Verschliisseln von Daten aus
Datenschutzgriinden erforderlich. Im Beschreibungsstandard ist deshalb vorgesehen, z. B.
Programme zur Entschlisselung oder zum Dekomprimieren direkt vom Datentrager zu
starten, ohne dass sich diese auf dem System der Finanzverwaltung installieren.

Die Computer der Prifer sind mit Zugriffsschutz-Software und ggf. Anti-Viren-Software
ausgestattet. Die Funktionsfahigkeit dieser direkt aufgerufenen Programme sollte deshalb
vom Daten-Bereitsteller im Vorfeld geklart werden. Die Prufung auf Lauffahigkeit dieser
Routinen ist nicht Gegenstand des Beschreibungsstandards.

Die Rolle des Softwareherstellers

Im Folgenden wird als ,Softwarehersteller” — aus Sicht des steuerpflichtigen Unternehmens —
ein externer Lieferant von Software oder einer Datenverarbeitungsanlage inklusive
Programmen oder eine interne Abteilung, die entsprechende Programme bzw. Services
bereitstellt, angenommen.

Gemalf den dargestellten Szenarien zur Betriebsprifung muss bei der Betriebsprifung u. a.
eine maschinenauswertbare Beschreibung der Daten und der VerknlUpfungen bereitgestellt
werden.

Die Beschreibungsdatei wird von einem Programm gelesen, das gemaf dieser
Beschreibung die Import-Funktion des Analyseprogramms des Steuerpriifers steuert. Es
werden keine Operationen auf Datenbanken der Produktivsysteme ausgefuhrt.

Der Hersteller der Programme bzw. Prozeduren, mit denen das steuerpflichtige
Unternehmen steuerrelevante Daten verarbeitet (Softwarehersteller), muss zusatzlich zu
einer Extraktionsfunktionalitat die Aufbereitung oder Bereitstellung der
Beschreibungsfunktionalitat sicherstellen.

Beschreibungsstandard GDPdU/GoBD 9
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XML-basierter Beschreibungsstandard

Uberblick

XML ist die ,eXtensible Markup Language®. XML gibt nur einen generischen Satz von
Sprachelementen vor, so dass je nach Anwendungsfall eine eigene Sprache definiert werden
muss. Die jeweils neu formulierte Sprache kann durch Strukturinformationen und
Elementdefinitionen in einer DTD (Document Type Definition) maschinenlesbar hinterlegt
werden. Damit kann ein XML-Parser Uberprifen (validieren), ob ein XML-Dokument der
vereinbarten Sprache entspricht. Man unterscheidet also zwischen Sprachbeschreibung in
der DTD und den Inhalten in der XML-Instanz.

In der DTD selbst werden also keine Beschreibungsdaten fiir die Datentrageriiberlassung
gespeichert, sondern in der XML-Datei index.xml. Die DTD beschreibt den Aufbau der Datei
index.xml.

Weiterfihrende Informationen zu XML findet man auf https://www.w3.0rqg.

Allgemeine Annahmen bzw. Voraussetzungen zur DTD

Es wird in der DTD davon ausgegangen, dass die steuerrelevanten Daten in Dateien
organisiert sind. Pro Tabelle wird genau eine Datei angenommen, so dass die Organisation
nach Datei und Tabelle physisch zusammenfallen.

Die Beschreibungsdaten fir die Datentrageriiberlassung werden in einer Datei index.xml
gespeichert.

Die DTD muss sich in demselben Verzeichnis auf dem Datentrager/in dem Datenpaket
befinden wie die Datei index.xml.

Werden mehrere Datentrager (Medien) bereitgestellt, muss sich die Datei index.xml nur auf
dem ersten Datentrager befinden.

Beschreibungsstandard GDPdU/GoBD 10
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Technischer Ablauf des Importprozesses

Der Importprozess wird von einer Komponente gesteuert, die die Datei index.xml interpretiert
und die Exporttabellen von den einzelnen Datentrdgern/Datenpaketen an die Analyse-
Software Ubergibt. Diese Komponente Uberprft die Datei index.xml auf Korrektheit und dient
dem Prifer als Inhaltsverzeichnis fur die gelieferten Daten.

GDPdU Interpreter

Analyse-
software

Abbildung 4: Importprozess

Beschreibungsstandard GDPdU/GoBD 11
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<?xml version="1.0" encoding="UTF-8"?>
<l--Versions available:
1.1 (August-01-2002)

1.2 (June-01-2003)
New Element Alias

1.3 (November-01-2003)
New Element Extension

1.4 (May-01-2004)
New Element AcceptNoTables
<Table> is now optional

1.5 (September-01-2004)
Updated the ForeignKey and Alias elements so they allow
multiple Alias elements per ForeignKey. This allows one to use alias
elements for a Composite key.

Example:

<ForeignKey>
<Name>Order</Name>
<Name>Customer</Name>
<References>Orders</References>
<Alias>
<From>Order</From>
<To>Orderld</To>
</Alias>
<Alias>
<From>Customer</From>
<To>Customerld</To>
</Alias>

1.6 (March-03-2019)
Updated the Map and From/To elements descriptions so they allow
importing an Alphanumeric column as Time column.
This allows defining that an Alphanumeric column contains
data of type Time and allows you to specify which is the time format used.

Example:

<Map>
<From>HHMMSS</From>
<To>HHMMSS</To>
</Map>
-—->

<l-- Start Simple Types -->

<l-- Supplementary Vocabulary -->
<IELEMENT Version (#PCDATA)>
<IELEMENT Location (#PCDATA)>
<IELEMENT Comment (#PCDATA)>
<IELEMENT Length (#PCDATA)>
<I[ELEMENT References (#PCDATA)>
<IELEMENT From (#PCDATA)>
<IELEMENT To (#PCDATA)>

<l-- Sometimes, it is desirable to have a <Media> with
no tables.

Example:
An extension might provide metadata
that describes all tax-relevant data.

This option is turned off by default. -->
<IELEMENT AcceptNoTables (#PCDATA)>

<!I-- Use Alias to reference columns with different names in
a ForeignKey element. These Alias elements are optional.

Beschreibungsstandard GDPdU/GoBD
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The following rules apply to the Alias element:
- One Alias can be used per ForeignKey.
- Alias elements can appear in any order.

Example:
Table Orders has a primary key Orderld
Table Accounts has a foreign key Order.

You can use the Alias element to specify Order references Orderld.

<ForeignKey>
<Name>Order</Name>
<Name>Customer</Name>
<References>Orders</References>
<Alias>
<From>Order</From>
<To>Orderld</To>
</Alias>
</ForeignKey> -->
<IELEMENT Alias (From, To)>

<l-- Specifying a maximum length for a VariableLength column can
reduce a VariableLength tables' import time. If MaxLength
is not specified then we parse URL to determine the MaxLength
for each column.

* Only applies to VariableLength tables. -->
<IELEMENT MaxLength (#PCDATA)>

<l-- Specifies which character (if any) encapsulates a
VariableLength AlphaNumeric column.

Doublequote is the default TextEncapsulator "

* Only applies to VariableLength tables. (Optional) -->
<IELEMENT TextEncapsulator (#PCDATA)>

<l-- Specifies how many digits appear to the right of the decimal symbol.

CAUTION: Results are undefined when importing numeric data with
greater Accuracy than the Accuracy defined in index.xml

For example trying to import the value 1000,25 with an
accuracy of 0 might result in 1000 or an error. This
behavior is specific to the implementation.

Zero is the default Accuracy '0' (Optional)
-->

<IELEMENT Accuracy (#PCDATA)>

<l-- The decimal place is not always stored with numbers. If each number
is supposed to have decimal places use ImpliedAccuracy -->
<IELEMENT ImpliedAccuracy (#PCDATA)>

<l-- Enables you to change how GDPdU displays dates.
DD.MM.YYYY is the default Format -->
<IELEMENT Format (#PCDATA)>

<l-- Specifies the symbol that indicates decimal values.
Comma is the default DecimalSymbol. ',
Specified once per Table. -->
<IELEMENT DecimalSymbol (#PCDATA)>

<l-- Specifies the symbol that groups the digits in large numbers.
Dot is the default DigitGroupingSymbol or ThousandsSeperator. *.'
Specified once per Table -->
<IELEMENT DigitGroupingSymbol (#PCDATA)>

<l-- Command(s) are executed in the following manner
* before the import process
* after the import process
* before a Media is imported
* after a Media is imported
>
<IELEMENT Command (#PCDATA)>

Beschreibungsstandard GDPdU/GoBD
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<l-- Only the file protocol is supported at this time.
* The standard uses relative URLs.

Absolute URLs are not allowed. The following are all invalid:
* http://www.somewhere.com/data/Accounts.dat
* ftp://ftp.somewhere.com/data/Accounts.dat
* file://localhost/Accounts.dat
* file:///Accounts.dat

The following are valid examples
* Accounts.dat
* data/Accounts.dat
* data/january/Accounts.dat
* .[Accounts.dat
>
<IELEMENT URL (#PCDATA)>

<l-- Textual description of specified element (Optional) -->
<IELEMENT Description (#PCDATA)>

<l-- The logical name of specified element.
Sometimes referred to business name.

If missing, URL will be used in place of Name. -->
<IELEMENT Name (#PCDATA)>

<l-- Y2K Window Any year before Epoch is 2000+
Default value 30. -->
<I[ELEMENT Epoch (#PCDATA)>

<!-- Element(s) that separate columns or records.
Semicolon is the default ColumnDelimiter. ;'
CRLF or &#13;&#10; is the default RecordDelimiter. -->
<IELEMENT ColumnDelimiter (#PCDATA)>
<IELEMENT RecordDelimiter (#PCDATA)>

<l-- The number of bytes skipped before reading of URL commences.
Zero is the default when not specified. '0'

->

<IELEMENT SkipNumBytes (#PCDATA)>

<l-- End Simple Types -->
<l-- Start Complex Types -->

<l-- Use Extension when you want to add application
specific functionality to the existing standard.

Name - the extension name or identifier.
URL - the supplementary .xml file that corresponds to the
extension.

An application that extends the standard should scan the
Dataset element for the presence of zero or more Extension
elements. The application can use the Name element to identify
the extension.

When choosing a name for your extension, do not choose a common
name. This will reduce undefined results for name conflicts.

It is possible that future extensions will be ratified as
mandatory to meet GDPdU guidelines. -->
<IELEMENT Extension (Name, URL)>

<l-- Self-explanatory -->
<IELEMENT Range (From, (To | Length)?)>
<IELEMENT FixedRange (From, (To | Length))>

<l-- The document element -->
<IELEMENT DataSet (Extension*, Version, DataSupplier?, Command*, Media+, Command*)>

<l-- Supported datatypes (mandatory) -->

<IELEMENT AlphaNumeric EMPTY>

<IELEMENT Date (Format?)>

<IELEMENT Numeric ((ImpliedAccuracy | Accuracy)?)>

Beschreibungsstandard GDPdU/GoBD 14
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<l-- Supported codepages:
Be careful to explicitly define RecordDelimiter when using
a non-default codepage.
ANSI is the default codepage when not specified -->
<IELEMENT ANSI EMPTY>
<IELEMENT Macintosh EMPTY>
<I[ELEMENT OEM EMPTY>
<I[ELEMENT UTF16 EMPTY>
<IELEMENT UTF7 EMPTY>
<I[ELEMENT UTF8 EMPTY>

<l-- Supported file formats:

FixedLength

VariableLength -->

<IELEMENT FixedLength ((Length | RecordDelimiter)?, ((FixedPrimaryKey+, FixedColumn*) | (FixedColumn+)),
ForeignKey*)>
<IELEMENT FixedColumn (Name, Description?, (Numeric | AlphaNumeric | Date), Map*, FixedRange)>
<IELEMENT FixedPrimaryKey (Name, Description?, (Numeric | AlphaNumeric | Date), Map*, FixedRange)>
<IELEMENT VariableLength (ColumnDelimiter?, RecordDelimiter?, TextEncapsulator?, ((VariablePrimaryKey+,
VariableColumn*) | (VariableColumn+)), ForeignKey*)>
<IELEMENT VariableColumn (Name, Description?, (Numeric | (AlphaNumeric, MaxLength?) | Date), Map*)>
<IELEMENT VariablePrimaryKey (Name, Description?, (Numeric | (AlphaNumeric, MaxLength?) | Date), Map*)>

<l-- Description of the entity supplying the data. (Optional) -->
<IELEMENT DataSupplier (Name, Location, Comment)>

<l-- The first Media will contain index.xml. Importing will process each media listed -->
<IELEMENT Media (Name, Command*, Table*, Command*, AcceptNoTables?)>

<l-- Elements common to FixedLength & VariableLength are propagated to Table. -->
<IELEMENT Table (URL, Name?, Description?, Validity?, (ANSI | Macintosh | OEM | UTF16 | UTF7 | UTF8)?,
(DecimalSymbol, DigitGroupingSymbol)?, SkipNumBytes?, Range?, Epoch?, (VariableLength | FixedLength))>

<l-- ForeignKeys denote joins or relationships between tables.
To successfully join two tables make sure both the PrimaryKey
and the referenced column (ForeignKey) are of the same datatype.
Results are undefined when joining two tables with different
key datatypes. Most likely an error will occur.

see line 35 for information about Alias -->
<IELEMENT ForeignKey (Name+, References, Alias*)>

<l-- Maps AlphaNumeric columns from 'From' to 'To'

ie. From To
True 1
True -1
False 0

Basically, a map is an associative container.

The standard implementation only supports
AlphaNumeric datatypes. The following
conversions are NOT supported.

Numeric ~ -> AlphaNumeric
Date -> AlphaNumeric
AplhaNumeric -> Date
AlphaNumeric -> Numeric

In order to keep the backward compatibility and because the Time
data type was not defined yet we allow specifying that an Alphanumeric
column contains data of type Time like:

<Map>
<From>HHMMSS</From>
<To>HHMMSS</To>
</Map>

If the application which interprets the xml and the target application
to import into are able to deal with time data type this column data could
be imported as Time data type

The value of the From element has to be equal with the value of the To
element, in order to not be interpreted as an actual Alphanumeric data mapping
in which the intention is to replace a certain text with a different text at

Beschreibungsstandard GDPdU/GoBD
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import time, and be a valid Time format.

The following formats are recognized as valid Time formats:
HH as symbols for hours

MM as symbols for minutes

SS as symbols for seconds

TT as symbols for AM/PM

SS and TT are optional when defining the format.

A time format separator can also be supplied if needed.

Examples of valid formats:
HHMM, HH:MM, HHMMSS, HHMMTT, HH:MMTT, HH:MM:SS, HHMMSSTT,
HH:MM:SSTT, HHMM TT, HH:MM TT, HHMMSS TT, HH:MM:SS TT

->

<IELEMENT Map (Description?, From, To)>

<l-- Documentation for table validity. -->
<IELEMENT Validity (Range, Format?)>

<l-- End Complex Types -->

Abbildung 5: XML-DTD
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Organisation des Beschreibungsstandards

a XML

= version 1.0
= encoding UTF-5
:| DOCTYPEDataSet

! DataSet
{} Version 10
| DataSupplier
{} Hame Glazwark AG
{} Location Singen/Deutschland
| {} Comment Datertrasgeriberlzssung nach GOPAU vom 14 August 2002, Dr. Gréssle, Tel: 07544 934266
Media ()
{} Hame {3} Table
1 CD Mummer 1} ¥ Table
> Table
2 CD Mummer 2 | > Table
> Table
> Table
4 Table
{3} URL hestelungen oy
{} Hame Bestelluncen
{} Description Bestelungen-Bewegungsdaten
| VariableLength
! VariableColumn (5]

]

{}Hame {} AlphaHumeric {} Date {} Humeric
1 Arikel-Mr
2 Kunden-Code
3 Bestellcatum Date
{} Format Y YMMOD
4 Lieferdatum Date
{} Format Y YMMOD
5 Besteldatum Date

{} Format v Y MMDD
_| & Frachtkosten

{ Commend wettere columns .
- ForeignKey (2]
{¥Hame {}References
1 Kunden-Code Kunden
| [ _ 2 | Atikel-D Artikel

Abbildung 6: Beschreibungsstandard — Organisation

Das Basiselement des Beschreibungsstandards ist das DataSet-Element. Hier enthalten sind
die Elemente Version, DataSupplier, Command und Media.

Version enthalt die Versionsnummer der Datentragerbereitstellung.

o DataSupplier enthalt Angaben Uber die Herkunft der Daten.

o Die Media-Container enthalten die Angaben tber die bereitgestellten Datentrager und die
Tabellen, die darauf gespeichert sind. Hierbei wird fur jedes bereitgestellte
Datentragermedium ein eigener Media-Eintrag vorgenommen. Somit ist es moglich, auch
mehrere Datentrdger in einem DataSet zusammenzufassen.
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Abbildung 7: Beschreibungsstandard — DataSet
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Abbildung 8: Beschreibungsstandard — FixedLength
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Abbildung 9: Beschreibungsstandard — VariableLength
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Hinweise zu XML

e Hinweis zu den in XML Ublichen Operatoren:

Operator Elementtyp darf auftreten
? 0-mal oder 1-mal

* 0-mal oder beliebig oft

+ 1-mal oder beliebig oft

Tabelle 3: Ubersicht iiber die gangigen Operatoren

o #PCDATA steht fur Parsed Character Data und bedeutet, dass das Element fiir einen
Texteintrag vorgesehen ist.

¢ Bei Aufzahlungen werden die mdglichen Werte durch senkrechte Striche (,|*) getrennt.

¢ In XML muss auf Grof3- und Kleinschreibung geachtet werden.

o Bitte verwenden Sie in den Beschreibungsfeldern und/oder den Tabellen- und
Spaltennamen keines der folgenden Zeichen: " & < >

Verwenden Sie stattdessen den Namen oder die Nummer aus der untenstehenden Liste.

Zeichen Name Nummer
- &quot; &#34;
& &amp; &#38;
< &lt; &#60;
> &at; &#62;

Tabelle 4: Liste der Namen und Nummern firr die Zeichen " & < >

Beschreibungsstandard GDPdU/GoBD
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Es folgt eine Beschreibung der einzelnen ELEMENT-Deklarationen.

Im Allgemeinen gilt, dass die in den jeweiligen Attributen ,description® hinterlegten Texte
dem Prifer als Kommentar angezeigt werden. Die Lange des Textes in den description-
Attributen sollte 255 Zeichen nicht Uberschreiten.

<IELEMENT Version (#PCDATA)>

Enthalt die Versionsnummer der Datentragerbereitstellung. Dieses Element hat keine
technische Auswirkung, sondern dient zur Beschreibung.

Verwendet in Container

Kontextabhéngige Beschreibung

DataSet

Tabelle 5: ELEMENT Version

<IELEMENT Location (#PCDATA)>
Beschreibt den Standort des Datenlieferanten.

Verwendet in Container

Kontextabhéngige Beschreibung

DataSupplier

Tabelle 6: ELEMENT Location

<IELEMENT Comment (#PCDATA)>

Kommentarfeld fir zusatzliche Informationen zum Datenlieferanten.

Verwendet in Container

Kontextabhéngige Beschreibung

DataSupplier

Tabelle 7: ELEMENT Comment

<IELEMENT Length (#PCDATA)>

Enthalt Informationen Uber die L&nge von Attributen oder Datensatzen.

Verwendet in Container

Kontextabhéngige Beschreibung

Range

Tabelle 8: ELEMENT Length

Beschreibungsstandard GDPdU/GoBD
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<IELEMENT References (#PCDATA)>
Enthalt Informationen Uber Verknipfungen.
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Verwendet in Container

Kontextabh&ngige Beschreibung

ForeignKey

referenzierte Tabelle

Tabelle 9: ELEMENT References

Siehe hierzu auch das Beispiel auf Seite 43.

<IELEMENT From (#PCDATA)>

Enthalt Informationen Uber den Startwert eines Wertebereichs.

Verwendet in Container

Kontextabhéangige Beschreibung

Range Startwert in einem Wertebereich
Map Redefinition von Daten
Alias Name der Spalte der aktuellen Tabelle, die

in einer Fremdschlisseldefinition verwendet
wird

Tabelle 10: ELEMENT From

<IELEMENT To (#PCDATA)>

Enthalt Informationen Uber den Endwert eines Wertebereichs.

Verwendet in Container

Kontextabhangige Beschreibung

Range Endwert in einem Wertebereich
Map Redefinition von Daten
Alias Der entsprechende Spaltenname der

referenzierten Tabelle fiir einen
Fremdschlissel

Tabelle 11: ELEMENT To

<IELEMENT MaxLength (#PCDATA)>

Enthalt Informationen Uber die maximale L&nge eines alphanumerischen Feldes in einer

VariableLength-Tabelle.

Verwendet in Container

Kontextabhéngige Beschreibung

VariableColumn

Maximale Lange des Feldes

VariablePrimaryKey

Maximale Lange des Feldes

Tabelle 12: ELEMENT MaxLength

Die Angabe von MaxLength bei dem Dateityp VariableLength beschleunigt den
Importprozess, da andernfalls die Datei vor dem Importprozess geprift wird und die

maximalen Langen der Felder ermittelt werden.

Beschreibungsstandard GDPdU/GoBD
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<IELEMENT TextEncapsulator (#PCDATA)>

Bei VariableLength-Dateien kann man Textfelder durch ein ,Encapsulator®-Zeichen
einschliel3en, z. B. fur den Fall, dass der Feldtrenner in den Daten vorkommt.

Vorgabewert: "

Verwendet in Container Kontextabh&ngige Beschreibung
VariableLength

Tabelle 13: ELEMENT TextEncapsulator

<IELEMENT Accuracy (#PCDATA)>

Anzahl der Nachkommastellen. Vorsicht bei Daten, deren Genauigkeit grof3er ist, als in
Accuracy angegeben.

Vorgabewert: 0

Verwendet in Container Kontextabhéangige Beschreibung
Numeric

Tabelle 14: ELEMENT Accuracy

<IELEMENT ImpliedAccuracy (#PCDATA)>

Anzahl der Nachkommastellen, auch wenn in den Quelldaten keine Nachkommastellen
angegeben sind.

Beispiel:
Quelldaten: ,100; 200; 102; 5000; 6587890
ImpliedAccuracy 3:,0,100; 0,200; 0,102; 5,000; 6587,890"

Verwendet in Container Kontextabhéngige Beschreibung
Numeric

Tabelle 15: ELEMENT ImpliedAccuracy
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Angabe Uber Formatdefinitionen.

Vorgabewert: DD.MM.YYYY
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Verwendet in Container

Kontextabhéngige Beschreibung

Date Hier wird die Maskierung fur die Darstellung
von Datumsangaben hinterlegt.
Folgende Angaben fiir Format sind gultig:
e DD fir Tag,
e MM flr Monat,
o YY bzw. YYYY fir Jahr.
Beispiel (30. September 2001)
e MM/DD/YY: 09/30/01
e DD.MM.YY: 30.09.01
e MM/DD/YYYY: 09/30/2001
e YYYY-MM-DD: 2001-09-30
e DDMMYY: 300901
e DDMMYYYY: 30092001
Validity Maskierung fur das verwendete

Datumsformat (siehe Date)

Tabelle 16: ELEMENT Format

<IELEMENT DecimalSymbol (#PCDATA)>

Angabe (lber das Dezimalstellen-Trennzeichen.

Vorgabewert: ,

Verwendet in Container

Kontextabhéngige Beschreibung

Table

Tabelle 17: ELEMENT DecimalSymbol

<IELEMENT DigitGroupingSymbol (#PCDATA)>

Definiert das Tausender-Trennzeichen.

Vorgabewert: .

Verwendet in Container

Kontextabhéngige Beschreibung

Table

Tabelle 18: ELEMENT DigitGroupingSymbol
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<IELEMENT Command (#PCDATA)>

Definiert ein Betriebssystemkommando. Commands kénnen an folgenden Stellen ausgefiihrt
werden:

e vor dem gesamten Importprozess

¢ nach dem gesamten Importprozess

e bevor ein einzelner Datentrager importiert wird

e nachdem ein einzelner Datentrager importiert wurde
Verwendet in Container Kontextabhéngige Beschreibung
DataSet Command flir den gesamten Vorgang
Media Command flr einen einzelnen Datentrager

Tabelle 19: ELEMENT Command

Siehe hierzu auch das Beispiel auf Seite 46.

<IELEMENT URL (#PCDATA)>
Dieses Element enthélt den physischen Dateinamen der bereitgestellten Datei.

In dieser Version des Beschreibungsstandards werden ausschlielich relative URLs
unterstitzt. Als Basisverzeichnis gilt der Pfad zur Datei index.xml.

Beispiele fur ungiltige Eintrage:
http:/mwww.somewhere.com/data/Accounts.csv
ftp://ftp.somewhere.com/data/Accounts.csv

Beispiele fur giltige Eintrage:
Accounts.dat
data/Accounts.dat
data/january/Accounts.dat
../Accounts.dat

Verwendet in Container Kontextabhéngige Beschreibung
Table

Tabelle 20: ELEMENT URL
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Verwendet in Container

Kontextabh&ngige Beschreibung

FixedColumn Beschreibungsfeld fiir Spalten in
FixedLength-Dateien
FixedPrimaryKey Beschreibungsfeld fur Schlissel in

FixedLength-Dateien

VariableColumn

Beschreibungsfeld fiir Spalten in
VariableLength-Dateien

VariablePrimaryKey Beschreibungsfeld fur Schliissel in
VariableLength-Dateien

Table Beschreibungsfeld fur Tabellen

Map Beschreibungsfeld flr Redefinition von

Daten

Tabelle 21: ELEMENT Description

<IELEMENT Name (#PCDATA)>
Beschreibungsfeld

Vorgabewert: Angabe aus dem URL-Element

Verwendet in Container

Kontextabhéngige Beschreibung

FixedColumn

Spaltenname in FixedLength-Dateien

FixedPrimaryKey Schlisselname in FixedLength-Dateien
VariableColumn Spaltenname in VariableLength-Dateien
VariablePrimaryKey Schliusselname in VariableLength-Dateien

DataSupplier

Name des Datenlieferanten
(Firmenname, ...)

Media Datentrdger-Name
URL Physischer Tabellenname
ForeignKey Name des Fremdschlissels

Tabelle 22: ELEMENT Name
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<IELEMENT Epoch (#PCDATA)>

Fur Daten, die eine 2-ziffrige Jahresangabe haben, kann ein Standardplatzhalter definiert
werden, der 19xx von 20xx trennt. Dieser Wert ist mit 30 vorbelegt.

In einigen Dateien konnte das Datum 25. November 55 entweder 1955 oder 2055 bedeuten.
Mit Epoch wird eingestellt, bis zu welchem zweistelligen Wert das Jahr als im néchsten
Jahrhundert liegend interpretiert werden soll. Steht beispielsweise im Feld Jahrhundert-
Trennwert der Wert 50, so werden alle Jahresangaben von 0 bis 49 als die Jahre 2000 bis
2049, die Jahresangaben 50 bis 99 als 1950 bis 1999 interpretiert.

Vorgabewert: 30

Verwendet in Container Kontextabhéngige Beschreibung
Table

Tabelle 23: ELEMENT Epoch

<IELEMENT ColumnDelimiter(#PCDATA)>
Definiert Trennzeichen fur Datenfelder.

Vorgabewert: &#59; (Semikolon ,;“)

Verwendet in Container Kontextabhangige Beschreibung
VariableLength Datenfeld-Trennzeichen

Tabelle 24: ELEMENT ColumnDelimiter

Beispiel fur Ubliche Trennzeichen:

Trennzeichen XML-Notation
Komma ,,,* &#44;
Semikolon ,;* &#59;

Tab &#9;

Tabelle 25: ELEMENT ColumnDelimiter — Liste gangiger Trennzeichen
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<IELEMENT RecordDelimiter (#PCDATA)>

Definiert Trennzeichen fir Datenséatze.

Vorgabewert: &#13;&#10; (CRLF)

audicon

Verwendet in Container

Kontextabhéngige Beschreibung

FixedLength

Datensatz-Trennzeichen

VariableLength

Datensatz-Trennzeichen

Tabelle 26: ELEMENT RecordDelimiter

Beispiel fur Ubliche Trennzeichen:

Trennzeichen

XML-Notation

CR Carriage Return &#13;
CRLF &#13;&#10;
LF Linefeed &#10;

Tabelle 27: ELEMENT RecordDelimiter — Liste gangiger Trennzeichen

<IELEMENT SkipNumBytes (#PCDATA)>

Falls eine Datei am Beginn unerwiinschte Daten enthalt, wie z. B. Datei-Header, ist hier
anzugeben, wie viele Bytes lUibersprungen und nicht gelesen werden sollen.

Vorgabewert: O

Verwendet in Container

Kontextabhéngige Beschreibung

Table

Tabelle 28: ELEMENT SkipNumBytes

<I[ELEMENT Range (From, (To | Length)?)>

Definiert einen Bereich oder einen Startwert.

Startwert bedeutet: Wird kein To oder Length angegeben, definiert dieser Range nur einen

Startwert (z. B. eine Datensatzposition).

Verwendet in Container

Kontextabhéngige Beschreibung

Table

Startdatensatz

Validity

Glltigkeitsbereich

Tabelle 29: ELEMENT Range
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<IELEMENT FixedRange (From, (To | Length))>
Definiert einen Bereich mit Angabe von From und To oder From und Length.

Verwendet in Container Kontextabh&ngige Beschreibung
FixedColumn Feldposition in FixedLength-Dateien
FixedPrimaryKey SchlUsselposition in FixedLength-Dateien

Tabelle 30: ELEMENT FixedRange

<IELEMENT DataSet (Version, DataSupplier?, Command*, Media+,
Command*)>

Das Element DataSet ist das oberste Element (document-Element) in der Hierarchie des
XML-Dokumentes. Das Element DataSet ist Trager der Version, Datenherkunft, Vorlauf- und
Nachlauf-Prozesse und der Medien, die die Tabellen enthalten.

<IELEMENT AlphaNumeric EMPTY>
Definiert den Datentyp als alphanumerisch.

Verwendet in Container Kontextabhéngige Beschreibung

FixedColumn Typ des Feldes in FixedLength-Datei

FixedPrimaryKey Typ des Schlussels in FixedLength-Datei

VariableColumn Typ des Feldes in VariableLength-Dateien

VariablePrimaryKey Typ des Schlissels in VariableLength-
Dateien

Tabelle 31: ELEMENT AlphaNumeric

<IELEMENT Date (Format?)>
Definiert den Datentyp als Datum.

Verwendet in Container Kontextabhéngige Beschreibung

FixedColumn Typ des Feldes in FixedLength-Datei

FixedPrimaryKey Typ des Schlissels in FixedLength-Datei

VariableColumn Typ des Feldes in VariableLength-Dateien

VariablePrimaryKey Typ des Schlissels in VariableLength-
Dateien

Tabelle 32: ELEMENT Date
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<IELEMENT Numeric ((ImpliedAccuracy | Accuracy)?)>
Definiert den Datentyp als numerisch.

Verwendet in Container Kontextabh&ngige Beschreibung

FixedColumn Typ des Feldes in FixedLength-Datei

FixedPrimaryKey Typ des Schlissels in FixedLength-Datei

VariableColumn Typ des Feldes in VariableLength-Dateien

VariablePrimaryKey Typ des Schlissels in VariableLength-
Dateien

Tabelle 33: ELEMENT Numeric

<IELEMENT ANSI EMPTY>
Legt die Verwendung der Codepage ANSI fest.

<IELEMENT Macintosh EMPTY>
Legt die Verwendung der Codepage Macintosh fest.

<IELEMENT OEM EMPTY>
Legt die Verwendung der Codepage IBM-PC-ASCII fest.

<IELEMENT UTF16 EMPTY>
Legt die Verwendung der Codepage UTF16 fest.

<IELEMENT UTF7 EMPTY>
Legt die Verwendung der Codepage UTF7 fest.
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<IELEMENT UTF8 EMPTY>
Legt die Verwendung der Codepage UTF8 fest.

Vorgabewert: ANSI

Plattform Zeichensatz

Unix-Rechner 7-Bit-ASCIlI-Zeichensatz (7-Bit-ISO Code,
US-Variante), nur Zeichen mit ASCII-Code
kleiner 128, also Buchstaben, Ziffern und
Sonderzeichen (Punkt, Komma etc.) ohne
nationale Sonderzeichen (Umlaute etc.) und
ohne Grafikzeichen. Zeilentrenner ist LF
(Line Feed), das Zeichen 10.

PC unter DOS 8-Bit-Zeichensatz ,IBM-PC-ASCII“, der in
den unteren 127 Zeichen dem 7-Bit-ASCI|
entspricht und ab Zeichen 128 nationale
Sonderzeichen und (Semi-)Grafikzeichen
enthalt. Zeilentrenner ist die Folge CR und
LF, das sind die Zeichen 12 und 10
(Carriage Return, Line Feed).

PC unter Windows 8-Bit-ANSI-Zeichensatz, der bis 127 ASCII
entspricht und oberhalb 127 nationale
Sonderzeichen enthélt, die nicht mit denen
des IBM-PC-ASCII Ubereinstimmen.
Zeilentrenner ist wie unter DOS die Folge
CR, LF. (Spezielle Anwendungen kénnen
auch einen 16-Bit-Code, den Unicode,
benutzen.)

Apple Mac Mac-spezifischer 8-Bit-Zeichensatz ,Mac-
ASCII¥, der bis 127 ASCII entspricht und
oberhalb 127 nationale Sonderzeichen
enthalt. Zeilentrenner ist CR.

Tabelle 34: ELEMENT UTF8

Die Wahl der Codepage setzt keine Vorgabe fir den RecordDelimiter. Sie miissen den
RecordDelimiter immer explizit angeben, wenn der Vorgabewert (CRLF) nicht geeignet ist.
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<IELEMENT FixedLength ((Length | RecordDelimiter)?, ((FixedPrimaryKey+,
FixedColumn*) | (FixedColumn+)), ForeignKey*)>

Definiert eine Datei vom Typ FixedLength.

Verwendet in Container

Kontextabhéngige Beschreibung

Table

Tabelle 35: ELEMENT FixedLength

<IELEMENT FixedColumn (Name, Description?, (Numeric | AlphaNumeric |

Date), Map*, FixedRange)>

Definiert eine Spalte (= Column) in einer Datei vom Typ FixedLength.

Verwendet in Container

Kontextabhéngige Beschreibung

FixedLength

Tabelle 36: ELEMENT FixedColumn

<IELEMENT FixedPrimaryKey (Name, Description?, (Numeric | AlphaNumeric |

Date), Map*, Range)>

Definiert ein Schlisselfeld (= Key) in einer Datei vom Typ FixedLength.

Verwendet in Container

Kontextabhangige Beschreibung

FixedLength

Tabelle 37: ELEMENT FixedPrimaryKey

Siehe hierzu auch das Beispiel auf Seite 43.

<IELEMENT VariableLength (ColumnDelimiter?, RecordDelimiter?,
TextEncapsulator?, ((VariablePrimaryKey+, VariableColumn?*) |

(VariableColumn+))?, ForeignKey*)>
Definiert eine Datei vom Typ VariableLength.

Verwendet in Container

Kontextabhangige Beschreibung

Table

Tabelle 38: ELEMENT VariableLength

Die Felder (VariableColumn, VariablePrimaryKey) missen in der Reihenfolge definiert

werden, in der sie in der Datei geliefert werden.
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<IELEMENT VariableColumn (Name, Description?, (Numeric | AlphaNumeric,
MaxLength ? | Date), Map*)>
Definiert eine Spalte (= Column) in einer Datei vom Typ VariableLength.

Verwendet in Container Kontextabhéngige Beschreibung
VariableLength

Tabelle 39: ELEMENT VariableColumn

Die Felder (VariableColumn, VariablePrimaryKey) missen in der Reihenfolge definiert
werden, in der sie in der Datei geliefert werden.

<IELEMENT VariablePrimaryKey (Name, Description?, (Numeric |
AlphaNumeric, MaxLength ? | Date), Map*)>
Definiert ein Schlisselfeld (= Key) in einer Datei vom Typ VariableLength.

Verwendet in Container Kontextabhéngige Beschreibung
VariableLength

Tabelle 40: ELEMENT VariablePrimaryKey

Die Felder (VariableColumn, VariablePrimaryKey) missen in der Reihenfolge definiert
werden, in der sie in der Datei geliefert werden.

Zu VerknlUpfungen siehe auch das Beispiel auf Seite 43.

<IELEMENT DataSupplier (Name, Location, Comment)>
Enthalt Angaben zum Datenlieferanten.

Verwendet in Container Kontextabhéngige Beschreibung
DataSet Lieferant (Firma, ...)

Tabelle 41: ELEMENT DataSupplier

<I[ELEMENT Media (Name, Command*, Table+, Command*)>
Definiert den Inhalt eines Datentragers.

Verwendet in Container Kontextabhédngige Beschreibung
DataSet Datentrdgeruberlassung

Tabelle 42: ELEMENT Media
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<IELEMENT Table (URL, Name?, Description?, Validity?, (ANSI | Macintosh |
OEM | UTF16 | UTF7 | UTF8)?, (DecimalSymbol, DigitGroupingSymbol)?,
SkipNumBytes?, Range?, (VariableLength | FixedLength)?)>

Definiert eine Tabelle.

audicon

Verwendet in Container

Kontextabh&ngige Beschreibung

Media

Tabelle

Tabelle 43: ELEMENT Table

<IELEMENT ForeignKey (Name+, References, Alias*)>

Definiert eine Spalte als Fremdschlissel.

Die Spalte, auf die mit Namen Bezug genommen wird, muss in der gleichen Tabelle als
FixedPrimaryKey/FixedColumn oder VariablePrimaryKey/VariableColumn definiert sein.
References ist der Name der referenzierten Tabelle und Alias wird verwendet, wenn die
referenzierte Spalte in der referenzierten Tabelle einen anderen Namen hat, siehe Definition

des Elements Alias fur weitere Informationen.

Verwendet in Container

Kontextabhéangige Beschreibung

FixedLength

Feld in FixedLength-Datei, referenzierte
Tabelle

VariableLength

Feld in VariableLength-Datei, referenzierte
Tabelle

Tabelle 44: ELEMENT ForeignKey

Siehe hierzu auch das Beispiel auf Seite 43.
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<IELEMENT Map (Description?, From, To)>
Mit dem Element Map kénnen Redefinitionen auf Datenebene vorgenommen werden.

Beispiel:
From (Ausgangsdaten) To (Zieldaten)
1 wahr
0 falsch
Hr Herr
Fr Frau
01 verheiratet
02 ledig
03 Steuerklasse 3

Tabelle 45: ELEMENT Map — Redefinitionen

Verwendet in Container Kontextabhéngige Beschreibung
FixedColumn Feld in FixedLength-Datei
FixedPrimaryKey Schliussel in FixedLength-Datei
VariableColumn Feld in VariableLength-Dateien
VariablePrimaryKey Schliussel in VariableLength-Dateien

Tabelle 46: ELEMENT Map

Map darf nur fir alphanumerische Felder benutzt werden.

Sie sollten vermeiden, in der Datentragertberlassung kodierte Felder zu liefern, sondern alle
Codes in die textuelle Beschreibung umwandeln. Wenn diese Umwandlung nicht bereits von
dem Exportprogramm vorgenommen wird, ist Map eine Mdglichkeit, Codes tber die
Datenbeschreibung umzuwandeln.

Mit Map kénnen Sie auch angeben, dass eine alphanumerische Spalte Daten vom Typ Zeit
enthalt:

<Map>
<From>HHMMSS</From>
<To>HHMMSS</To>
</Map>

Wenn die Anwendung, die die XML-Datei interpretiert, und die Zielanwendung, in die
importiert werden soll, mit dem Datentyp Zeit umgehen kdnnen, kdnnen die Daten dieser
Spalte als Datentyp Zeit importiert werden.
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Der Wert des From-Elements muss gleich dem Wert des To-Elements sein, damit er nicht als
alphanumerisches Daten-Mapping interpretiert wird, bei dem ein bestimmter Text beim
Import durch einen anderen Text ersetzt werden soll, und ein giltiges Time-Format ist.

Die folgenden Formate werden als gliltige Zeitformate anerkannt:
HH als Symbole fir Stunden
MM als Symbole fiir Minuten
SS als Symbole fur Sekunden
TT als Symbole fur AM/PM
SS und TT sind bei der Definition des Formats optional.
Bei Bedarf kann auch ein Zeitformattrennzeichen angegeben werden.

Beispiele fir giltige Formate:
HHMM, HH:MM, HHMMSS, HHMMTT, HH:MMTT, HH:MM:SS, HHMMSSTT,
HH:MM:SSTT, HHMM TT, HH:MM TT, HHMMSS TT, HH:MM:SS TT

<IELEMENT Validity (Range, Format?)>
Definiert den Gultigkeitszeitraum der Daten.

Verwendet in Container Kontextabhéangige Beschreibung
Table Glltigkeitszeitraum

Tabelle 47: ELEMENT Validity

<IELEMENT AcceptNoTables (#PCDATA)>
Legt fest, dass ein <Media> keine Tabellen hat.

Verwendet in Container Kontextabhéngige Beschreibung
Media Media hat keine Tabellen

Tabelle 48: ELEMENT AcceptNoTables

Manchmal ist es wiinschenswert, ein <Media> ohne Tabellen zu haben.

Beispiel:

Eine Erweiterung kénnte Metadaten bereitstellen, die alle steuerrelevanten Daten
beschreiben.
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<IELEMENT Alias (From, To)>

Definiert das entsprechende Spaltennamenpaar bei der Definition einer
Fremdschlisselreferenz.

Verwendet in Container Kontextabhéngige Beschreibung
ForeignKey Fur einen Spaltennamen den Namen der
Spalte angeben, auf die er in der
referenzierten Tabelle verweist

Tabelle 49: ELEMENT Alias

Verwenden Sie Alias, um auf Spalten mit unterschiedlichen Namen in einem ForeignKey-
Element zu verweisen. Diese Alias-Elemente sind optional.
Die folgenden Regeln gelten fir das Alias-Element:

e Ein oder mehrere Alias-Elemente kénnen pro ForeignKey verwendet werden.
¢ Alias-Elemente kdnnen in beliebiger Reihenfolge erscheinen.

Beispiel:
Die Tabelle Orders hat einen Priméarschlissel Orderld
Die Tabelle Accounts hat einen Fremdschliissel Order.

Sie kdnnen das Alias-Element verwenden, um anzugeben, dass Order auf Orderld verweist.

<ForeignKey>
<Name>Order</Name>
<Name>Customer</Name>
<References>0Orders</References>
<Alias>
<From>Order</From>
<To>Orderld</To>
</Alias>
</ForeignKey>
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<IELEMENT Extension (Name, URL)>

Ermdglicht es Ihnen, den bestehenden Standard um anwendungsspezifische Funktionen zu
erweitern.

Verwendet in Container Kontextabhéngige Beschreibung
DataSet

Tabelle 50: ELEMENT Extension

Verwenden Sie Extension, wenn Sie dem bestehenden Standard anwendungsspezifische
Funktionen hinzufiigen méchten.

Name — Name oder Kennung der Erweiterung.
URL — zusatzliche XML-Datei, die der Erweiterung entspricht.

Eine Anwendung, die den Standard erweitert, sollte das Element Dataset auf das
Vorhandensein von null oder mehr Extension-Elementen tberprifen. Die Anwendung kann
das Element Name verwenden, um die Erweiterung zu identifizieren.

Wenn Sie einen Namen fir Ihre Erweiterung wéhlen, sollten Sie keinen allgemeinen Namen
wahlen. Dadurch werden undefinierte Ergebnisse fur Namenskonflikte vermieden.

Es ist mdglich, dass zukinftige Erweiterungen als obligatorisch eingestuft werden, um die
GDPdU-/GoBD-Richtlinien zu erftllen.
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Beispiel 1 fur eine Datei index.xml

<?xml version="1.0" encoding="UTF-8"?>
<IDOCTYPE DataSet SYSTEM "gdpdu-01-08-2002.dtd">
<DataSet>
<Version>1.0</Version>
<DataSupplier>
<Name>Glaswerk AG</Name>
<Location>Singen/Deutschland</Location>
<Comment>Datentraegeriberlassung nach GDPdU vom 14.August 2002, Dr. Gréassle, Tel: 07544
934266</Comment>
</DataSupplier>
<Media>
<Name>CD Nummer 1</Name>
<Table>
<URL>Account.csv</URL>
<Name>Account</Name>
<Description>Accounts Receivables</Description>
<l-- Diese Tabelle gilt von 1.Januar 2000- 31.Dezember 2002 -->
<Validity>
<Range>
<From>20000101</From>
<T0>20021231</To>
</Range>
<Format>YYYYMMDD</Format>
</Validity>
<I-- Spezifiziert den Dezimaltrenner -->
<DecimalSymbol>.</DecimalSymbol>
<l-- Spezifiziert den Tausender-Separator -->
<DigitGroupingSymbol>,</DigitGroupingSymbol>
<VariableLength>
<!-- ein zusammengesetzter Primaerschlissel -->
<VariablePrimaryKey>
<Name>Regionld</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariablePrimaryKey>
<Name>ld</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Account Description</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Balance</Name>
<Numeric/>
</VariableColumn>
<VariableColumn>
<Name>Old Balance</Name>
<Numeric/>
</VariableColumn>
</VariableLength>
</Table>
<Table>
<URL>Region.csv</URL>
<VariableLength>
<VariablePrimaryKey>
<Name>Regionld</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Description</Name>
<AlphaNumeric/>
</VariableColumn>
</VariableLength>
</Table>
</Media>
<Media>
<Name>CD Nummer 2</Name>
<Table>
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<URL>Sales.csv</URL>
<Range>
<From>56</From>
</Range>
<FixedLength>
<FixedPrimaryKey>
<Name>Salesld</Name>
<AlphaNumeric/>
<FixedRange>
<!I-- Position des Feldes: -->
<From>1</From>
<To>10</To>
</FixedRange>
</FixedPrimaryKey>
<FixedColumn>
<Name>Regionld</Name>
<AlphaNumeric/>
<FixedRange>
<From>11</From>
<Length>10</Length>
</FixedRange>
</FixedColumn>
<FixedColumn>
<Name>ld</Name>
<AlphaNumeric/>
<FixedRange>
<From>21</From>
<To>30</To>
</FixedRange>
</FixedColumn>
<FixedColumn>
<Name>SalesComplete</Name>
<AlphaNumeric/>
<!-- Redefinition des Wertes "1" nach "True" und "0" nach "False" -->
<Map>
<From>1</From>
<To>True</To>
</Map>
<Map>
<From>0</From>
<To>False</To>
</Map>
<FixedRange>
<From>31</From>
<To0>32</To>
</FixedRange>
</FixedColumn>
<!-- ein zusammengesetzter Fremdschluessel der den Primaerschluessel in Tabelle Account
referenziert -->
<ForeignKey>
<Name>Regionld</Name>
<Name>ld</Name>
<References>Account</References>
</ForeignKey>
</FixedLength>
</Table>
<Table>
<URL>kunden.csv</URL>
<Name>Kunden</Name>
<Description>Kunden-Stammdaten</Description>
<VariableLength>
<VariablePrimaryKey>
<Name>Kunden-Code</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Firma</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Kontaktperson</Name>
<AlphaNumeric/>
</VariableColumn>
<!-- weitere columns... -->
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</VariableLength>
</Table>
<Table>
<URL>artikel.csv</URL>
<Name>Artikel</Name>
<Description>Artikel-Stammdaten</Description>
<VariableLength>
<VariablePrimaryKey>
<Name>Artikel-Nr</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Artikelname</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Lieferanten-Nr</Name>
<AlphaNumeric/>
</VariableColumn>
<I-- weitere columns... -->
</VariableLength>
</Table>
<Table>
<URL>bestellungen.csv</URL>
<Name>Bestellungen</Name>
<Description>Bestellungen-Bewegungsdaten</Description>
<VariableLength>
<VariableColumn>
<Name>Artikel-Nr</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Kunden-Code</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Bestelldatum</Name>
<Date>
<Format>YYYYMMDD</Format>
</Date>
</VariableColumn>
<VariableColumn>
<Name>Lieferdatum</Name>
<Date>
<Format>YYYYMMDD</Format>
</Date>
</VariableColumn>
<VariableColumn>
<Name>Bestelldatum</Name>
<Date>
<Format>YYYYMMDD</Format>
</Date>
</VariableColumn>
<VariableColumn>
<Name>Frachtkosten</Name>
<Numeric/>
</VariableColumn>
<I-- weitere columns... -->
<ForeignKey>
<Name>Kunden-Code</Name>
<References>Kunden</References>
</ForeignKey>
<ForeignKey>
<Name>Artikel-ID</Name>
<References>Artikel</References>
</ForeignKey>
</VariableLength>
</Table>
</Media>
</DataSet>

Abbildung 10: Beispiel 1 — Datei index.xml
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Beispiel 2 fur Verkntpfungen

In der Datentragertberlassung kann es sinnvoll sein, Bewegungsdaten und Stammdaten

nicht in einer breiten Tabelle zu liefern, sondern in getrennten Tabellen abzuspeichern:

Beispiel:

Kunden

e
KUNDEN_CODE

FIRMA

[KONTAKTPERSON
POSITION
STRARE

Artikel

ARTIKELNAME
LEFERANTEN_NR
KATEGORIENR

ORT

Bestellungen

LEFEREINHEIT

REGION
PLZ
ILAND
TELEFON
[TELEFAX

EINZELPREIS

*

ARTIKEL_NR

(| [KUNDEN_CODE

[BESTELLDATUM
LIEFERDATUM
FRACHTKOSTEN
[EMPFANGER
STRARE

omT
[BESTIMMUNGSLAND
[EINZELPREIS
ANZAHL

RABATT

LAGERBESTAND
BESTELLTEEINHEITEN
MINDESTBESTAND
AUSLAUFARTIKEL

*
ARTKEL_NR

Abbildung 11: Beispiel 2 — Tabellen mit Bewegungsdaten und Stammdaten

In den Stammdaten werden die Primarschliissel beschrieben:

<Table>
<URL>kunden.csv</URL>
<Name>Kunden</Name>

<VariableLength>
<VariablePrimaryKey>
<Name>Kunden-Code</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Firma</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Kontaktperson</Name>
<AlphaNumeric/>
</VariableColumn>
<l-- weitere columns... -->
</VariableLength>
</Table>

<Description>Kunden-Stammdaten</Description>

<Table>

<URL>artikel.csv</URL>
<Name>Artikel</Name>
<Description>Artikel-Stammdaten</Description>
<VariableLength>
<VariablePrimaryKey>
<Name>Artikel-Nr</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Artikelname</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Lieferanten-Nr</Name>
<AlphaNumeric/>
</VariableColumn>
<l-- weitere columns... -->
</VariableLength>

</Table>

Abbildung 12: Beispiel 2 — Stammdaten
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Die Bewegungsdaten beschreiben die Verknipfungen zu den Stammdaten Uber die Angabe

der Fremdschlisselbeziehung:

<Table>
<URL>bestellungen.csv</URL>
<Name>Bestellungen</Name>

<VariableLength>

<Description>Bestellungen-Bewegungsdaten</Description>

<VariableColumn>
<Name>Artikel-Nr</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Kunden-Code</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Bestelldatum</Name>
<Date>
<Format>YYYYMMDD</Format>
</Date>
</VariableColumn>
<VariableColumn>
<Name>Lieferdatum</Name>
<Date>
<Format>YYYYMMDD</Format>
</Date>
</VariableColumn>
<VariableColumn>
<Name>Bestelldatum</Name>
<Date>
<Format>YYYYMMDD</Format>
</Date>
</VariableColumn>
<VariableColumn>
<Name>Frachtkosten</Name>
<Numeric/>
</VariableColumn>
<l-- weitere columns... -->
<ForeignKey>
<Name>Kunden-Code</Name>
<References>Kunden</References>
</ForeignKey>
<ForeignKey>
<Name>Artikel-Nr</Name>
<References>Artikel</References>
</ForeignKey>

</VariableLength>
</Table>

Abbildung 13: Beispiel 2 — Bewegungsdaten
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Bitte beachten Sie:
Wahrend die Beschreibung eines VariablePrimaryKey die Spalte vollstdndig beschreibt,

definiert ForeignKey keine neue Spalte. Die im ForeignKey benutzte Spalte muss vorher
bereits als VariableColumn oder FixedColumn definiert worden sein.

<ForeignKey>
<Name>FIRM</Name>
<Name>DDKZ</Name>
<Name>KKKZ</Name>
<Name>UKTO</Name>
<Name>BUJM</Name>
<References>FPCPDPU</References>
<Alias>
<From>UKTO</From>
<To>CKTO</To>
</Alias>
<Alias>
<From>BUJM</From>
<To>GAJM</To>
</Alias>
</ForeignKey>

Abbildung 14: Beispiel 2 — Beispiel eines Fremdschlussels mit mehreren Aliassen
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Beispiel 3 fur eine Datei index.xml (komprimierte Daten)

index.xml

<?xml version="1.0" encoding="UTF-8"?>
<IDOCTYPE DataSet SYSTEM "gdpdu-01-08-2002.dtd">
<DataSet>
<Version>1.2</Version>
<DataSupplier>
<Name>Audicon GmbH</Name>
<Location>Germany</Location>
<Comment>A compressed sample DataSet</Comment>
</DataSupplier>
<Command>uncompress.bat</Command>
<Media>
<Name>Disk 1</Name>
<Table>
<URL>dummy.csv</URL>
<VariableLength>
<VariablePrimaryKey>
<Name>dummy</Name>
<Numeric/>
</VariablePrimaryKey>
</VariableLength>
</Table>
</Media>
</DataSet>

Abbildung 15: Beispiel 3 — Datei index.xml

uncompress.bat
rem
rem uncompress.bat
rem expandiert gdpdu.zip in das windows-temp-verzeichnis, unterverzeichnis gdpdu
rem
mkdir %temp%\gdpdu
pkunzip gdpdu.zip %temp%)\gdpdu

Abbildung 16: Beispiel 3 — Datei uncompress.bat

%temp% ist eine Betriebssystem-Umgebungsvariable, die den Pfad zum Temporar-
Verzeichnis reprasentiert.

Die Datei gdpdu.zip enthélt die gepackte Datentragerbereitstellung (einschlief3lich der Datei
index.xml und gdpdu-01-08-2002.dtd). Der Prufer 6ffnet nach dem Dekomprimieren also die
neue Datenbereitstellung in dem Verzeichnis % TEMP%\gdpdu.

Bitte beachten Sie:

Die <Version>-Angabe bezieht sich nicht auf die Version des Beschreibungsstandards,
sondern auf die Version der Datentrageriiberlassung.
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Beispiel 4 fur eine Datei index.xml (Datentyp Zeit)

index.xml
<?xml version="1.0" encoding="utf-8" standalone="no"?>
<!DOCTYPE DataSet SYSTEM "gdpdu-01-03-2019.dtd">
<DataSet>
<Version>1.0.00</Version>
<DataSupplier>
<Name />
<Location />
<Comment>SmartExporter</Comment>
</DataSupplier>
<Media>
<Name>Disk1</Name>
<Table>
<URL>20181120175609__ BKPF.csv</URL>
<Name>BKPF</Name>
<Description>
</Description>
<UTF8 />
<DecimalSymbol>.</DecimalSymbol>
<DigitGroupingSymbol>,</DigitGroupingSymbol>
<VariablelLength>
<ColumnDelimiter> </ColumnDelimiter>
<TextEncapsulator />
<VariableColumn>
<Name>BUKRS</Name>
<Description>Company Code</Description>
<AlphaNumeric />
<MaxLength>4</MaxLength>
</VariableColumn>
<VariableColumn>
<Name>BELNR</Name>
<Description>Accounting Document Number</Description>
<AlphaNumeric />
<MaxLength>10</MaxLength>
</VariableColumn>
<VariableColumn>
<Name>BLDAT</Name>
<Description>Document Date in Document</Description>
<Date>
<Format>YYYYMMDD</Format>
</Date>
</VariableColumn>
<VariableColumn>
<Name>BUDAT</Name>
<Description>Posting Date in the Document</Description>
<Date>
<Format>YYYYMMDD</Format>
</Date>
</VariableColumn>
<VariableColumn>
<Name>CPUTM</Name>
<Description>Time of Entry</Description>
<AlphaNumeric />
<MaxLength>6</MaxLength>
<Map>
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<From>HH :MM</From>
<To>HH:MM</To>
</Map>
</VariableColumn>
<VariableColumn>
<Name>CPUTM1</Name>
<Description>Time of Entry</Description>
<AlphaNumeric />
<MaxLength>7</MaxLength>
<Map>
<From>HH:MMTT</From>
<TOo>HH:MMTT</To>
</Map>
</VariableColumn>
<VariableColumn>
<Name>CPUTM2</Name>
<Description>Time of Entry</Description>
<AlphaNumeric />
<MaxLength>9</MaxLength>
<Map>
<From>HH:MM:SSTT</From>
<TO>HH:MM:SSTT</To>
</Map>
</VariableColumn>
<VariableColumn>
<Name>CPUTM3</Name>
<Description>Time of Entry</Description>
<AlphaNumeric />
<MaxLength>6</MaxLength>
<Map>
<From>HHMM< /From>
<To>HHMM< /To>
</Map>
</VariableColumn>
<VariableColumn>
<Name>CPUTM4< /Name>
<Description>Time of Entry</Description>
<AlphaNumeric />
<MaxLength>7</MaxLength>
<Map>
<From>HHMMTT</From>
<To>HHMMTT</To>
</Map>
</VariableColumn>
<VariableColumn>
<Name>CPUTM5</Name>
<Description>Time of Entry</Description>
<AlphaNumeric />
<MaxLength>9</MaxLength>
<Map>
<From>HHMMSS</From>
<To>HHMMSS</To>
</Map>
</VariableColumn>
<VariableColumn>
<Name>CPUTM6</Name>
<Description>Time of Entry</Description>
<AlphaNumeric />
<MaxLength>9</MaxLength>
<Map>
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<From>HHMMSSTT</From>
<TO>HHMMSSTT</To>
</Map>
</VariableColumn>
<VariableColumn>
<Name>CPUTM7</Name>
<Description>Time of Entry</Description>
<AlphaNumeric />
<MaxLength>9</MaxLength>
<Map>
<From>HH:MM:SS</From>
<TO>HH:MM:SS</To>
</Map>
</VariableColumn>
<VariableColumn>
<Name>CPUTM8</Name>
<Description>Time of Entry</Description>
<AlphaNumeric />
<MaxLength>10</MaxLength>
<Map>
<From>HHMMSS</From>
<To>HHMMSS</To>
</Map>
</VariableColumn>
</VariablelLength>
</Table>
</Media>
</DataSet>

Abbildung 17: Beispiel 4 — Datei index.xml mit Datentyp Zeit
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Haufig gestellte Fragen

e Mussen wir die Daten im XML-Format liefern?
Nein. Nur die Beschreibung der Daten (Datei index.xml) ist im XML-Format. Die
Nutzdaten sind im FixedLength- oder VariableLength-Format.

e Kann Ihr System mit Daten in DOS/Unix/Mac-Formaten (Zeilentrenner) umgehen?
Ja, denn die Zeilentrenner kbnnen explizit angegeben werden.

e Wie sind negative Zahlen darzustellen (vor/hinter der Zahl, Leerzeichen zwischen
Vorzeichen und Zahl erlaubt)?
Negativen Zahlen ist ein Minuszeichen ohne Leerstelle vor- oder nachzustellen (z. B.
.-1782,90“ oder ,1782,90-).

e Wenn eine Uberlassene Datei zu grol3 fur einen Datentréger ist, kann sie dann auf
mehrere Datentrager gesplittet werden?
Der Beschreibungsstandard sieht ein Splitten einer Datei nicht vor. In diesem Fall kdnnen
Sie aber die Daten komprimieren oder ein Speichermedium mit grof3erer Kapazitat (z. B.
DVD) wahlen.

e Welchen XML-Parser verwenden Sie?
Wir verwenden Xerces (https://xerces.apache.org/xerces-c/).

e st es ein Fehler, wenn ForeignKey eine Tabelle referenziert, die nicht im DataSet
enthalten ist, oder wirde der ForeignKey dann ignoriert werden?
Die Beschreibung der Verlinkungen muss mit den gelieferten Daten lbereinstimmen,
andernfalls ist Ihre Datentrageriberlassung nicht konsistent. Der Import-Prozess weist
den Prifer auf die Inkonsistenz hin.

e Was passiert, wenn in der Datei index.xml eine Tabelle beschrieben wird, die aber
anschlielRend nicht vorhanden ist?
Die Beschreibung der Dateien muss mit den gelieferten Dateien Ubereinstimmen,
andernfalls ist Ihre Datentrageriberlassung nicht konsistent. Der Import-Prozess weist
den Prifer auf die Inkonsistenz hin.
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e Sind Commands zwingend erforderlich? Stellen Sie fur Commands
Umgebungsvariablen zur Verfiigung?
Commands sind nicht zwingend erforderlich. Wenn eine BAT- oder CMD-Datei
aufgerufen wird, stehen die ublichen Betriebssystem-Umgebungsvariablen zur
Verfligung. Der Import-Prozess setzt selbst keine Umgebungsvariablen.

e Wie kann abschlie3end geprift werden, ob die Daten des
Datentragers/Datenpakets von lhrem System eingelesen werden kénnen?
Die sichere Variante der Priufung ist der Import mit IDEA fir GDPdU/GoBD (IDEA +
SmartX). SmartV hilft Ihnen, die Beschreibungsstandard-Konformitét der Datei index.xml
und der zu importierenden Daten zu tberprifen.

Eine einfache Moglichkeit, die XML-Datei auf ihre syntaktische Korrektheit zu testen, ist,
sie mit einem XML-fahigen Browser zu 6ffnen.

e Daich mit XML-Standards nicht vertraut bin, ist mir nicht klar, wie ich die Dateien
index.xml und gdpdu.dtd konkret aufzubauen habe. Ich habe Ihnen eine
VariableLength-Datei zugeschickt; kdnnen Sie mir die korrespondierende XML-
bzw. DTD-Datei erstellen?

Sie sollten sich Grundkenntnisse in XML aneignen, die DTD-Datei mussen (durfen!) Sie
nicht modifizieren.

Die Beschreibung der Daten (in der Datei index.xml) sollte immer von der Stelle aus
geschehen, die die Datenhoheit besitzt, also vom Softwarehersteller oder
steuerpflichtigen Unternehmen.

Audicon unterstitzt Sie bei der Uberpriifung, ob die Datentrageriiberlassung mit dem
Beschreibungsstandard tibereinstimmt, und bei der Erstellung der Datei index.xml (siehe
https://www.audicon.net/consulting/dienstleistungspakete/).

e In einigen Pressemitteilungen werden aul3er VariableLength und FixedLength noch
zahlreiche weitere Dateiformate genannt. Welche Formate sind fir die
Datentragertberlassung relevant?

Die in einigen Artikeln genannten Dateiformate beziehen sich auf die originaren Import-
Madglichkeiten der Software IDEA.

Der Beschreibungsstandard ist aber produktunabhangig und unterstitzt in der aktuellen
Version nur die beiden allgemeingultigen Formate VariableLength und FixedLength.

e Muss die Datei gdpdu-01-08-2002.dtd mit auf dem Datentrager gespeichert
werden?
Ja. Ein Datentrager, der zur Datentrageriberlassung dient, muss die Datei gdpdu-01-08-
2002.dtd, die Datei index.xml und alle Nutzdaten (z. B. T1.CSV, T2.CSV, T3.CSV,
T4.ASC) enthalten.
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e In einer VariableLength-Datei sind im ersten Datensatz die Feldnamen gespeichert.
Wie kann man den ersten Satz tuberlesen?
Verwenden Sie die Range-Angabe im Table-Element:

<Table>
<Range>
<From>2</From>
</Range>
<URL>Region.csv</URL>
<VariableLength>
<VariablePrimaryKey>
<Name>Regionld</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Description</Name>
<AlphaNumeric/>
</VariableColumn>
</VariableLength>
</Table>

Abbildung 18: Range-Angabe

e Wird durch die Angabe eines Zeichensatzes, z. B. UTF7 oder Macintosh, die
Angabe des Zeilenbegrenzers automatisch ubersteuert?
Nein. Nur die explizite Angabe des Zeilenbegrenzers (RecordDelimiter) Ubersteuert den
Vorgabewert (CRLF).
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Umbenennungen sind blau gekennzeichnet, neue oder geléschte Elemente rot.
Version 1.0 vom 10. Mai 2002 (6.6.2002) Version 1.1 vom 1. August 2002
<?xml version="1.0" encoding="UTF-8"?> <?xml version="1.0" encoding="UTF-8"?>
<!--Versions available: <!--Versions available:
1.0 (May-10-2002) 1.1 (August-01-2002)
-—> -—>
<!-- Start Simple Types --> <!-- Start Simple Types -->
<!-- Supplementary Vocabulary --> <!-- Supplementary Vocabulary -->
<!ELEMENT Version (#PCDATA)> <!ELEMENT Version (#PCDATA)>
<!ELEMENT Location (#PCDATA)> <!ELEMENT Location (#PCDATA)>
<!ELEMENT Comment (#PCDATA) > <!ELEMENT Comment (#PCDATA)>
<!ELEMENT Length (#PCDATA)> <!ELEMENT Length (#PCDATA)>
<!ELEMENT References (#PCDATA) > <!ELEMENT References (#PCDATA)>
<!ELEMENT From (#PCDATA)> <!ELEMENT From (#PCDATA)>
<!ELEMENT To (#PCDATA)> <!ELEMENT To (#PCDATA)>
<!-- Specifying a maximum length for a VariableLength column
can reduce a VariablelLength tables' import time.
If MaxLength is not specified then we parse URL to determine
the MaxLength for each column.
* Only applies to Variablelength tables. -->
<!ELEMENT MaxLength (#PCDATA)>
<!-- Specifies which character encapsulates a <!-- Specifies which character (if any) encapsulates a

CSV text column -->

<!ELEMENT TextEncapsulator (#PCDATA)>
<!-- Specifies how many digits appear to the right of
the decimal symbol. -->

VariableLength AlphaNumeric column.
Doublequote is the default TextEncapsulator "

* Only applies to Variablelength tables. (Optional) -
>
<!ELEMENT TextEncapsulator (#PCDATA)>
<!-- Specifies how many digits appear to the right of the

decimal symbol.
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CAUTION:
Results are undefined when importing numeric data with
greater Accuracy than the Accuracy defined in index.xml

For example trying to import the wvalue 1000,25 with an

accuracy of 0 might result in 1000 or an error. This
behavior is specific to the implementation.
Zero is the default Accuracy '0O' (Optional)
-—>
<!ELEMENT Accuracy (#PCDATA)> <!ELEMENT Accuracy (#PCDATA)>
<!-- The decimal place is not always stored with <!-- The decimal place is not always stored with numbers. If
numbers. If each number is supposed to have decimal each number is supposed to have decimal places use
places use ImpliedAccuracy --> ImpliedAccuracy -->
<!ELEMENT ImpliedAccuracy (#PCDATA)> <!ELEMENT ImpliedAccuracy (#PCDATA)>
<!-- The first line in CSV URL contains column headers.
A value of False is interpreted if the element is
missing. Any columns specified in the XML file take
precedence over the file. This lets you override some
columns in the file and leave the others as they are.
-=>
<!ELEMENT NamesFirstRow EMPTY>
<!-- Enables you to change how gdpdu displays dates. <!-- Enables you to change how gdpdu displays dates.
The default is implementation dependant. --> DD.MM.YYYY is the default Format -->
<!ELEMENT Format (#PCDATA)> <!ELEMENT Format (#PCDATA)>
<!-- Specifies the symbol that indicates decimal values. | <!-- Specifies the symbol that indicates decimal values.
The default is implementation dependant. Comma is the default DecimalSymbol. ','
Specified once per Table. --> Specified once per Table. -->
<!ELEMENT DecimalSymbol (#PCDATA) > <!ELEMENT DecimalSymbol (#PCDATA)>
<!-- Specifies the symbol that groups the digits in <!-- Specifies the symbol that groups the digits in large
large numbers. numbers. Dot is the default DigitGroupingSymbol or
The default is implementation dependant. ThousandsSeperator. '.
Specified once per Table --> Specified once per Table -->
<!ELEMENT DigitGroupingSymbol (#PCDATA) > <!ELEMENT DigitGroupingSymbol (#PCDATA) >
<!-- Command(s) are executed in the following manner <!-- Command(s) are executed in the following manner
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The root path is the path of Media

The following are all invalid
* http://www.somewhere.com/data/Accounts.csv

* ftp://ftp.somewhere.com/data/Accounts.csv
*

The following is wvalid.
* file://Accounts.csv

<!ELEMENT URL (#PCDATA) >

<!-- Textual description of specified element -->
<!ELEMENT Description (#PCDATA)>

<!-- The logical names of specified element -->

<!ELEMENT Name (#PCDATA) >

<!-- Y2K Window Any year before Epoch is 2000+
Default value 50. -->

caseware | audicon
Version 1.0 vom 10. Mai 2002 (6.6.2002) Version 1.1 vom 1. August 2002
* before the import process * before the import process

* after the import process * after the import process

* before a Media is imported * before a Media is imported

* after a Media is imported * after a Media is imported
-—> -—>
<!ELEMENT Command (#PCDATA)> <!ELEMENT Command (#PCDATA) >
<!-- Only the file protocol is supported at this time. <!-- Only the file protocol is supported at this time.

* The standard uses relative URLs.

Absolute URLs are not allowed. The following are all
invalid:
* http://www.somewhere.com/data/Accounts.dat
* ftp://ftp.somewhere.com/data/Accounts.dat
* file://localhost/Accounts.dat
* file:///Accounts.dat

The following are valid examples
* Accounts.dat
* data/Accounts.dat
* data/january/Accounts.dat
* . ./Accounts.dat
-—>

<!ELEMENT URL (#PCDATA)>

<!-- Textual description of specified element (Optional) -->
<!ELEMENT Description (#PCDATA)>

<!-- The logical name of specified element.
Sometimes referred to business name.

If missing, URL will be used in place of Name. -->
<!ELEMENT Name (#PCDATA)>
<!-- Y2K Window Any year before Epoch is 2000+
Default value 30. -->
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<!ELEMENT Epoch (#PCDATA)> <!ELEMENT Epoch (#PCDATA)>
<!-- Specifies the symbol that seperates CSV columns or <!-- Element(s) that separate columns or records.
ASCITIFixedLength records. --> Semicolon is the default ColumnDelimiter. ';'
<!ELEMENT Delimiter (#PCDATA)> CRLF or &#13;&#10; is the default RecordDelimiter. -->
<!ELEMENT ColumnDelimiter (#PCDATA)>
<!ELEMENT RecordDelimiter (#PCDATA)>
<!-- The number of bytes skipped before reading of URL <!-- The number of bytes skipped before reading of URL
commences. —--> commences. Zero is the default when not specified. '0' -->
<!ELEMENT SkipNumBytes (#PCDATA)> <!ELEMENT SkipNumBytes (#PCDATA) >
<!-- End Simple Types --> <!-- End Simple Types -->
<!-- Start Complex Types --> <!-- Start Complex Types -->
<!-- Self-explanetory --> <!-- Self-explanatory -->
<!ELEMENT Range (From, (To | Length)?)> <!ELEMENT Range (From, (To | Length)?)>

<!-- The document element -->
<!ELEMENT DataSet (Version, DataSupplier?, Command¥*,
Media+, Command*) >
<!-- Supported datatypes

AlphaNumeric is the default datatype when a
datatype is not defined. -->

<!ELEMENT AlphaNumeric EMPTY>
<!ELEMENT Date (Format?, Epoch?)>
<!ELEMENT Numeric ((ImpliedAccuracy | Accuracy)?)>

<!'ELEMENT FixedRange (From, (To | Length))>

<!-- The document element -->
<!ELEMENT DataSet (Version, DataSupplier?,
Command¥*) >

Command*, Media+,

<!-- Supported datatypes (mandatory) -->

<!ELEMENT AlphaNumeric EMPTY>
<!ELEMENT Date (Format?)>

<!ELEMENT Numeric ((ImpliedAccuracy | Accuracy)?)>

<!-- Supported codepages:

Be careful to explicitly define RecordDelimiter when using a
non-default codepage.

ANSI is the default codepage when not specified -->
<!ELEMENT ANSI EMPTY>

<!'ELEMENT Macintosh EMPTY>

<!'ELEMENT OEM EMPTY>

<!'ELEMENT UTF16 EMPTY>

<!'ELEMENT UTF7 EMPTY>

<!ELEMENT UTF8 EMPTY>
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<!-- Supported file formats -->

<!ELEMENT ASCIIFixedLength ((Length | Delimiter)?,
((FixedPrimaryKey+, FixedColumn*) | (FixedPrimaryKey*,
FixedColumn+)), ForeignKey*)>

<!ELEMENT FixedColumn (Name, Description?,
AlphaNumeric | Date)?, Map*, Range)>
<!ELEMENT FixedPrimaryKey (Name, Description?,
| AlphaNumeric | Date)?, Map*, Range)>
<!ELEMENT CSV (NamesFirstRow?, Delimiter?,
TextEncapsulator?, ((PrimaryKey+, Column*) |
(PrimaryKey*, Column+))?, ForeignKey¥*)>
<!ELEMENT Column (Name, Description?, (Numeric |
AlphaNumeric | Date)?, Map*)>

<!ELEMENT PrimaryKey (Name, Description?,
AlphaNumeric | Date)?, Map*)>

(Numeric |

(Numeric

(Numeric |

<!-- Description of the entity supplying the data.
(Optional) -->
<!ELEMENT DataSupplier Comment) >

(Name, Location,

<!-- The first Media will contain index.xml.
will process each media listed -->
<!ELEMENT Media (Name, Command*, Table+,

Importing

Command*) >

<!-- Elements common to ASCCIIFIXEDLENGTH & CSV are
propagated to Table.
CSV is the default format if none is specified. -->

<!ELEMENT Table
(DecimalSymbol,
Range?, (CSV |

(URL, Name?, Description?, Validity?,
DigitGroupingSymbol) ?, SkipNumBytes?,
ASCIIFixedLength) ?)>

<!-- ForeignKeys denote joins and relationships between
tables.

Not specifying ForeignKeys prevent joins from
occurring. -->

<!-- Supported file formats: FixedLength, VariableLength -->
<!ELEMENT FixedLength ((Length | RecordDelimiter)?,
((FixedPrimaryKey+, FixedColumn*) | (FixedColumn+)),
ForeignKey*) >

<!ELEMENT FixedColumn (Name, Description?,
AlphaNumeric | Date), Map*, FixedRange)>
<!ELEMENT FixedPrimaryKey (Name, Description?,
AlphaNumeric | Date), Map*, FixedRange)>
<!ELEMENT VariableLength (ColumnDelimiter?, RecordDelimiter?,
TextEncapsulator?, ((VariablePrimaryKey+, VariableColumn*) |
(VariableColumn+) ) , ForeignKey*)>

<!ELEMENT VariableColumn (Name, Description?,
(AlphaNumeric, MaxLength?) | Date), Map*)>
<!'ELEMENT VariablePrimaryKey (Name, Description?,
(AlphaNumeric, MaxLength?) | Date), Map*)>

(Numeric |

(Numeric |

(Numeric |

(Numeric |

<!-- Description of the entity supplying the data. (Optional)
-——>
<!ELEMENT DataSupplier Comment) >

(Name, Location,

<!-- The first Media will contain index.xml.
process each media listed -->
<!ELEMENT Media (Name, Command*,

Importing will

Table+, Command*)>

<!-- Elements common to FixedLength & VariableLength are
propagated to Table. -->

<!'ELEMENT Table (URL, Name?, Description?, Validity?, (ANSI |
Macintosh | OEM | UTF16 | UTF7 | UTF8)?, (DecimalSymbol,
DigitGroupingSymbol) ?, SkipNumBytes?, Range?, Epoch?,
(VariableLength | FixedLength))>

<!-- ForeignKeys denote joins or relationships between
tables. To successfully join two tables make sure both the
PrimaryKey and the referenced column (foreignkey) are of the
same datatype.

Results are undefined when joining two tables with different
key datatypes. Most likely an error will occur. -->
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<!ELEMENT ForeignKey (Name+, References)>

<!-- Maps data from 'From' to 'To'
ie. From To
True 1
True -1
False 0

A map 1is basically an associative container.
Take caution that 'From' is of the same type
as the column datatype.

<!ELEMENT Map (Description?, From, To)>

<!-- Documentation for table wvalidity. -->
<!ELEMENT Validity (Range, Format?)>

<!-- End Complex Types —-->

<!ELEMENT ForeignKey (Name+, References)>

<!-- Maps AlphaNumeric columns from 'From' to 'To'
ie. From To
True 1
True -1
False 0

Basically, a map is an associative container.

The standard implementation only supports
AlphaNumeric datatypes. The following
conversions are NOT supported.

Numeric -> AlphaNumeric
Date -> AlphaNumeric
AplhaNumeric -> Date
AlphaNumeric -> Numeric

-—>

<!ELEMENT Map (Description?, From, To)>

<!-- Documentation for table wvalidity. -->
<!ELEMENT Validity (Range, Format?)>

<!-- End Complex Types -->

Tabelle 51: Gegeniberstellung Beschreibungsstandard Version 1.0 und 1.1
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Synopse Beschreibungsstandard Version 1.1 und Version 1.6

Umbenennungen sind blau gekennzeichnet, neue oder geléschte Elemente rot.

Version 1.1 vom 1. August 2002

Version 1.6 vom 1. Marz 2019

<?xml version="1.0" encoding="UTF-8"7?>
<!--Versions available:

1.1 (August-01-2002)

-—>

<?xml version="1.0" encoding="UTF-8"?>
<!--Versions available:
1.1 (August-01-2002)

1.2 (June-01-2003)
New Element Alias

1.3 (November-01-2003)
New Element Extension

1.4 (May-01-2004)
New Element AcceptNoTables
<Table> is now optional

1.5 (September-01-2004)
Updated the ForeignKey and Alias elements so they allow
multiple Alias elements per ForeignKey. This allows one
to use alias elements for a Composite key.

Example:

<ForeignKey>
<Name>Order</Name>
<Name>Customer</Name>
<References>Orders</References>
<Alias>
<From>Order</From>
<To>OrderId</To>
</Alias>
<Alias>
<From>Customer</From>
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<!-- Start Simple Types -->

<!-- Supplementary Vocabulary -->
<!ELEMENT Version (#PCDATA)>
<!ELEMENT Location (#PCDATA)>
<!ELEMENT Comment (#PCDATA)>
<!ELEMENT Length (#PCDATA)>
<!ELEMENT References (#PCDATA)>
<!ELEMENT From (#PCDATA)>
<!ELEMENT To (#PCDATA)>

<To>CustomerId</To>
</Alias>

1.6 (March-03-2019)

Updated the Map and From/To elements descriptions so
they allow importing an Alphanumeric column as Time
column.

This allows defining that an Alphanumeric column
contains data of type Time and allows you to specify which
is the time format used.

Example:

<Map>
<From>HHMMSS</From>
<To>HHMMSS</To>
</Map>
-—>
<!-- Start Simple Types -->

<!-- Supplementary Vocabulary -->
<!ELEMENT Version (#PCDATA)>
<!ELEMENT Location (#PCDATA)>
<!ELEMENT Comment (#PCDATA) >
<!ELEMENT Length (#PCDATA)>
<!ELEMENT References (#PCDATA)>
<!ELEMENT From (#PCDATA)>
<!ELEMENT To (#PCDATA)>

<!-- Sometimes, it is desirable to have a <Media> with no
tables.

Example:
An extension might provide metadata that describes all
tax-relevant data.

This option is turned off by default. -->
<!'ELEMENT AcceptNoTables (#PCDATA)>
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<!-- Specifying a maximum length for a Variablelength
column can reduce a Variablelength tables' import time. If
MaxLength is not specified then we parse URL to determine
the MaxLength for each column.

* Only applies to VariablelLength tables. -->
<!ELEMENT MaxLength (#PCDATA)>
<!-- Specifies which character (if any) encapsulates a

VariableLength AlphaNumeric column.
Doublequote is the default TextEncapsulator "

<!-- Use Alias to reference columns with different names
in a ForeignKey element. These Alias elements are
optional.

The following rules apply to the Alias element:
- One Alias can be used per ForeignKey.
- Alias elements can appear in any order.

Example:
Table Orders has a primary key OrderId
Table Accounts has a foreign key Order.

You can use the Alias element to specify Order
references OrderId.

<ForeignKey>
<Name>Order</Name>
<Name>Customer</Name>
<References>Orders</References>
<Alias>
<From>Order</From>
<To>OrderId</To>
</Alias>
</ForeignKey> -->
<!'ELEMENT Alias (From, To)>

<!-- Specifying a maximum length for a VariableLength
column can reduce a Variablelength tables' import time. If
MaxLength is not specified then we parse URL to determine
the MaxLength for each column.

* Only applies to VariablelLength tables. -->
<!ELEMENT MaxLength (#PCDATA)>
<!-- Specifies which character (if any) encapsulates a

VariableLength AlphaNumeric column.
Doublequote is the default TextEncapsulator "
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* Only applies to VariablelLength tables. (Optional) * Only applies to VariablelLength tables. (Optional)
-—> -—>
<!ELEMENT TextEncapsulator (#PCDATA)> <!ELEMENT TextEncapsulator (#PCDATA)>
<!-- Specifies how many digits appear to the right of the <!-- Specifies how many digits appear to the right of the

decimal symbol.

CAUTION: Results are undefined when importing
numeric data with greater Accuracy than the Accuracy
defined in index.xml

For example trying to import the value 1000,25 with an
accuracy of 0 might result in 1000 or an error. This
behavior is specific to the implementation.

Zero is the default Accuracy '0O' (Optional)
-—>
<!ELEMENT Accuracy (#PCDATA) >
<!-- The decimal place is not always stored with numbers.

If each number is supposed to have decimal places use
ImpliedAccuracy —-->

<!ELEMENT ImpliedAccuracy (#PCDATA)>
<!-- Enables you to change how GDPdU displays dates.

DD.MM.YYYY is the default Format -->
<!ELEMENT Format (#PCDATA)>

<!-- Specifies the symbol that indicates decimal values.
Comma is the default DecimalSymbol. ','
Specified once per Table. -->
<!ELEMENT DecimalSymbol (#PCDATA) >
<!-- Specifies the symbol that groups the digits in large

numbers.

decimal symbol.

CAUTION: Results are undefined when importing
numeric data with greater Accuracy than the Accuracy
defined in index.xml

For example trying to import the wvalue 1000,25 with an
accuracy of 0 might result in 1000 or an error. This
behavior is specific to the implementation.

Zero is the default Accuracy '0O' (Optional)
-——>
<!ELEMENT Accuracy (#PCDATA)>
<!-- The decimal place is not always stored with numbers.

If each number is supposed to have decimal places use
ImpliedAccuracy -->

<!ELEMENT ImpliedAccuracy (#PCDATA)>
<!-- Enables you to change how GDPdU displays dates.

DD.MM.YYYY is the default Format -->
<!ELEMENT Format (#PCDATA)>

<!-- Specifies the symbol that indicates decimal values.
Comma is the default DecimalSymbol. ','
Specified once per Table. -->
<!ELEMENT DecimalSymbol (#PCDATA)>
<!-- Specifies the symbol that groups the digits in large

numbers.
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Dot is the default DigitGroupingSymbol or
ThousandsSeperator. '.'
Specified once per Table -->
<!ELEMENT DigitGroupingSymbol (#PCDATA) >
<!-- Command(s) are executed in the following manner
* before the import process
* after the import process
* before a Media is imported
* after a Media is imported
-—>
<!ELEMENT Command (#PCDATA) >
<!-- Only the file protocol is supported at this time.
* The standard uses relative URLs.

Absolute URLs are not allowed. The following are
all invalid:
* http://www.somewhere.com/data/Accounts.dat
* ftp://ftp.somewhere.com/data/Accounts.dat
* file://localhost/Accounts.dat
* file:///Accounts.dat

The following are valid examples
* Accounts.dat
* data/Accounts.dat
* data/january/Accounts.dat
* . ./Accounts.dat
-—>
<!ELEMENT URL (#PCDATA)>
<!-- Textual description of specified element
->

(Optional)

<!ELEMENT Description (#PCDATA)>
<!-- The logical name of specified element.

Dot is the default DigitGroupingSymbol or

ThousandsSeperator. '.'
Specified once per Table -->
<!ELEMENT DigitGroupingSymbol (#PCDATA)>
<!-- Command(s) are executed in the following manner
* before the import process
* after the import process
* before a Media is imported
* after a Media is imported

-——>
<!ELEMENT Command (#PCDATA) >
<!-- Only the file protocol is supported at this time.

* The standard uses relative URLs.

Absolute URLs are not allowed.
all invalid:
* http://www.somewhere.com/data/Accounts.dat
* ftp://ftp.somewhere.com/data/Accounts.dat
* file://localhost/Accounts.dat
* file:///Accounts.dat

The following are

The following are valid examples
* Accounts.dat
* data/Accounts.dat
* data/january/Accounts.dat
* ../Accounts.dat
-—>
<!ELEMENT URL (#PCDATA)>
<!-- Textual description of specified element
->

(Optional)

<!ELEMENT Description (#PCDATA)>
<!-- The logical name of specified element.
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Sometimes referred to business name. Sometimes referred to business name.
If missing, URL will be used in place of Name. --> If missing, URL will be used in place of Name. -->
<!ELEMENT Name (#PCDATA) > <!ELEMENT Name (#PCDATA) >
<!-- Y2K Window Any year before Epoch is 2000+ <!-- Y2K Window Any year before Epoch is 2000+
Default wvalue 30. --> Default value 30. -—>
<!ELEMENT Epoch (#PCDATA)> <!ELEMENT Epoch (#PCDATA)>
<!-- Element (s) that separate columns or records. <!-- Element (s) that separate columns or records.

Semicolon is the default ColumnDelimiter. ';'
CRLF or &#13;&#10; 1is the default RecordDelimiter.
-——>
<!ELEMENT ColumnDelimiter (#PCDATA)>
<!ELEMENT RecordDelimiter (#PCDATA)>

<!-- The number of bytes skipped before reading of URL
commences.

Zero is the default when not specified. '0'
-—>

<!ELEMENT SkipNumBytes (#PCDATA) >

<!-- End Simple Types -->
<!-- Start Complex Types -->

Semicolon is the default ColumnDelimiter. ';
CRLF or &#13;&#10; 1is the default RecordDelimiter.
-——>
<!ELEMENT ColumnDelimiter (#PCDATA)>
<!ELEMENT RecordDelimiter (#PCDATA)>

<!-- The number of bytes skipped before reading of URL
commences.
Zero is the default when not specified. '0'
-—>
<!ELEMENT SkipNumBytes (#PCDATA) >

<!-- End Simple Types -->
<!-- Start Complex Types —-->
<!-- Use Extension when you want to add application

specific functionality to the existing standard.

Name - the extension name or identifier.

URL - the supplementary .xml file that corresponds
to the extension.

An application that extends the standard should scan
the Dataset element for the presence of zero or more
Extension elements. The application can use the Name
element to identify the extension.
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<!-- Self-explanatory -->
<!ELEMENT Range (From, (To | Length)?)>
<!ELEMENT FixedRange (From, (To | Length))>

<!-- The document element -->
<!ELEMENT DataSet (Version, DataSupplier?, Command*,
Media+, Command*) >

<!-- Supported datatypes (mandatory) -->

<!ELEMENT AlphaNumeric EMPTY>

<!ELEMENT Date (Format?)>

<!ELEMENT Numeric ((ImpliedAccuracy | Accuracy)?)>

<!-- Supported codepages:
Be careful to explicitly define RecordDelimiter when
using a non-default codepage.
ANSI is the default codepage when not specified -->
<!ELEMENT ANSI EMPTY>
<!ELEMENT Macintosh EMPTY>
<!ELEMENT OEM EMPTY>
<!ELEMENT UTF16 EMPTY>
<!ELEMENT UTF7 EMPTY>
<!ELEMENT UTF8 EMPTY>

<!-- Supported file formats:
FixedLength
VariableLength -->

When choosing a name for your extension, do not
choose a common name. This will reduce undefined results
for name conflicts.

It is possible that future extensions will be
ratified as mandatory to meet GDPdU guidelines. -->
<!'ELEMENT Extension (Name, URL)>

<!-- Self-explanatory -->
<!ELEMENT Range (From, (To | Length)?)>
<!ELEMENT FixedRange (From, (To | Length))>

<!-- The document element -->
<!ELEMENT DataSet (Extension*, Version, DataSupplier?,
Command*, Media+, Command*)>

<!-- Supported datatypes (mandatory) -->

<!ELEMENT AlphaNumeric EMPTY>

<!ELEMENT Date (Format?)>

<!ELEMENT Numeric ((ImpliedAccuracy | Accuracy)?)>

<!-- Supported codepages:
Be careful to explicitly define RecordDelimiter when
using a non-default codepage.
ANSI is the default codepage when not specified -->
<!ELEMENT ANSI EMPTY>
<!ELEMENT Macintosh EMPTY>
<!ELEMENT OEM EMPTY>
<!ELEMENT UTF16 EMPTY>
<!ELEMENT UTF7 EMPTY>
<!ELEMENT UTF8 EMPTY>

<!-- Supported file formats:
FixedLength
VariableLength -->
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<!ELEMENT FixedLength ((Length |
((FixedPrimaryKey+, FixedColumn*) |
ForeignKey*) >

RecordDelimiter) ?,
(FixedColumn+) ),

<!ELEMENT FixedColumn
AlphaNumeric | Date),

(Name, (Numeric |

Map*,

Description?,
FixedRange) >

<!ELEMENT FixedPrimaryKey (Name, Description?, (Numeric

AlphaNumeric | Date), Map*, FixedRange)>

<!ELEMENT VariableLength (ColumnDelimiter?,
RecordDelimiter?, TextEncapsulator?,
((VariablePrimaryKey+, VariableColumn*) |
(VariableColumn+)), ForeignKey*)>

<!ELEMENT VariableColumn (Name, Description?,
(AlphaNumeric, MaxLength?) | Date), Map¥*)>

(Numeric |

<!ELEMENT VariablePrimaryKey (Name, Description?, (Numeric

| (AlphaNumeric, MaxLength?) | Date), Map¥*)>

<!-- Description of the entity supplying the data.
(Optional) -->

<!ELEMENT DataSupplier (Name, Location, Comment) >
<!-— The first Media will contain index.xml.

will process each media listed -->

Importing

<!ELEMENT Media (Name, Command*, Table+, Command*)>

<!-- Elements common to FixedLength & VariableLength are
propagated to Table. -->

<!ELEMENT Table (URL, Name?, Description?, Validity?,
(ANSI | Macintosh | OEM | UTF16 | UTF7 | UTFS8)?,
(DecimalSymbol, DigitGroupingSymbol)?, SkipNumBytes?,
Range?, Epoch?, (VariablelLength | FixedLength))>

<!ELEMENT FixedLength ((Length |
((FixedPrimaryKey+, FixedColumn*) |
ForeignKey*) >

RecordDelimiter) ?,
(FixedColumn+) ),

<!ELEMENT FixedColumn
AlphaNumeric | Date),

(Name, (Numeric |

Map*,

Description?,
FixedRange) >
<!ELEMENT FixedPrimaryKey (Name, Description?, (Numeric |
AlphaNumeric | Date), Map*, FixedRange)>

<!ELEMENT VariableLength (ColumnDelimiter?,
RecordDelimiter?, TextEncapsulator?,
((VariablePrimaryKey+, VariableColumn*) |
(VariableColumn+) ), ForeignKey*)>

<!ELEMENT VariableColumn (Name, Description?, (Numeric |
(AlphaNumeric, MaxLength?) | Date), Map¥*)>
<!ELEMENT VariablePrimaryKey (Name, Description?, (Numeric
| (AlphaNumeric, MaxLength?) | Date), Map*)>

<!-- Description of the entity supplying the data.
(Optional) -->
<!ELEMENT DataSupplier (Name, Location, Comment)>
<!-- The first Media will contain index.xml.
will process each media listed -->
<!'ELEMENT Media (Name, Command*, Table*,

AcceptNoTables?) >

Importing

Command*,

<!-- Elements common to FixedLength & VariableLength are
propagated to Table. -->

<!ELEMENT Table (URL, Name?, Description?, Validity?,
(ANSI | Macintosh | OEM | UTFl16 | UTF7 | UTFES8)?,
(DecimalSymbol, DigitGroupingSymbol)?, SkipNumBytes?,
Range?, Epoch?, (Variablelength | FixedLength))>
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<!-- ForeignKeys denote joins or relationships between <!-- ForeignKeys denote Jjoins or relationships between
tables. tables.

To successfully join two tables make sure both the
PrimaryKey and the referenced column (foreignkey) are of
the same datatype.

Results are undefined when joining two tables with
different key datatypes. Most likely an error will occur.
-—>
<!ELEMENT ForeignKey (Name+, References)>

<!-- Maps AlphaNumeric columns from 'From' to 'To'
ie. From To
True 1
True -1
False 0

Basically, a map is an associative container.

The standard implementation only supports
AlphaNumeric datatypes. The following
conversions are NOT supported.

Numeric -> AlphaNumeric
Date -> AlphaNumeric
AplhaNumeric -> Date
AlphaNumeric -> Numeric

To successfully join two tables make sure both the
PrimaryKey and the referenced column (ForeignKey) are of
the same datatype.

Results are undefined when joining two tables with
different key datatypes. Most likely an error will occur.
see line 35 for information about Alias -->
<!ELEMENT ForeignKey (Name+, References, Alias¥*)>

<!-- Maps AlphaNumeric columns from 'From' to 'To'
ie. From To
True 1
True -1
False 0

Basically, a map 1s an associative container.

The standard implementation only supports
AlphaNumeric datatypes. The following
conversions are NOT supported.

Numeric -> AlphaNumeric
Date -> AlphaNumeric
AplhaNumeric -> Date
AlphaNumeric -> Numeric

In order to keep the backward compatibility and
because the Time data type was not defined yet we allow
specifying that an Alphanumeric

column contains data of type Time like:

<Map>
<From>HHMMSS</From>
<To>HHMMSS</To>
</Map>
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<!ELEMENT Map (Description?, From, To)>

<!-- Documentation for table wvalidity. -->
<!ELEMENT Validity (Range, Format?)>

<!-- End Complex Types —-->

If the application which interprets the xml and the
target application

to import into are able to deal with time data type
this column data could

be imported as Time data type

The value of the From element has to be equal with
the value of the To

element, in order to not be interpreted as an actual
Alphanumeric data mapping

in which the intention is to replace a certain text
with a different text at

import time, and be a valid Time format.

The following formats are recognized as valid Time
formats:

HH as symbols for hours

MM as symbols for minutes

SS as symbols for seconds

TT as symbols for AM/PM

SS and TT are optional when defining the format.

A time format separator can also be supplied if
needed.

Examples of valid formats:

HHMM, HH:MM, HHMMSS, HHMMTT, HH:MMTT, HH:MM:SS,
HHMMSSTT,

HH:MM:SSTT, HHMM TT, HH:MM TT, HHMMSS TT, HH:MM:SS
TT
-—>
<!ELEMENT Map (Description?, From, To)>

<!-- Documentation for table validity. -->
<!ELEMENT Validity (Range, Format?)>

<!-- End Complex Types -->

Tabelle 52: Gegeniiberstellung Beschreibungsstandard Version 1.1 und 1.6
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